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Finding Words
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To find a word using the Find command:

1. Click the Find button (Binoculars), or choose Edit > Find.

2. Enter the text to find in the text box.

3. Select search options if necessary:

Match Whole Word Only finds only occurrences of the complete word you enter in the box.  For example, if you search for the word stick, the words tick and sticky will not be highlighted.

Match Case finds only words that contain exactly the same capitalization you enter in the box.

Find Backwards starts the search from the current page and goes backwards through the document.

4. Click Find.  Acrobat Reader finds the next occurrence of the word.

To find the next occurrence of the word, Do one of the following:

            Choose Edit > Find Again 

            Reopen the find dialog box, and click Find Again. 

            (The word must already be in the Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it into another application such as a word processor.  You can also paste text into a PDF document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you can switch to another application and paste it into another document.  

Note:  If a font copied from a PDF document is not available on the system displaying the copied text, the font cannot be preserved.  A default font  is substituted.

To select and copy it to the clipboard:

1. Select the text tool T, and do one of the following:

       To select a line of text, select the first letter of the sentence or phrase and drag to

       the last letter.  

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option (Mac OS) as you drag across the width of the document. 

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command (Mac OS) as you drag the length of the document.

To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text on the current page is selected.  In Continuous or Continuous – facing mode, most of the text in the document is selected.  When you release the mouse button, the selected text is highlighted.  To deselect the text and start over, click anywhere outside the selected text.  

The Select All command will not select all the text in the document.  A workaround for this (Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected text to the clipboard.

2. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.
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]

SUP. KNABE, CHAIRMAN: GOOD MORNING, WELCOME. IF YOU WOULD ALL PLEASE RISE. WE WILL BE LED THIS MORNING IN AN INVOCATION BY RABBI JOEL SIMONDS, UNIVERSITY SYNAGOGUE HERE IN LOS ANGELES, FOLLOWED BY THE PLEDGE OF ALLEGIANCE LED BY JOHN L. STAMATIADES, COMMANDER, 17TH DISTRICT, THE AMERICAN LEGION. RABBI? 

RABBI JOEL SIMONDS: HAVING JUST CELEBRATED THE ANNIVERSARY OF OUR COUNTRY'S INDEPENDENCE, WE ARE REMINDED OF THE IDEALS AND VALUES UPON WHICH THIS COUNTRY WAS FOUNDED. WE ARE REMINDED THAT ALL MEN AND WOMEN ARE CREATED EQUAL AND THAT WE HAVE UNALIENABLE RIGHTS, THE RIGHT TO LIFE, THE RIGHT TO LIBERTY, THE RIGHT TO HAPPINESS. BUT IT IS IMPORTANT TO REMEMBER THAT WITH THESE RIGHTS COMES RESPONSIBILITY. RESPONSIBILITY TO ONE ANOTHER. THE GREAT 20TH CENTURY PHILOSOPHER, MARTIN BUBER, WROTE ABOUT THE DIFFERENCE BETWEEN AN I-IT AND AN I-THOU RELATIONSHIP. IN AN I-IT RELATIONSHIP, WE VIEW THE OTHER PERSON AS AN OBJECT, WE SUBJUGATE THE OTHER PERSON, WE DEPERSONALIZE HIM. WE DENY HER UNALIENABLE RIGHTS. BUT THE I-THOU RELATIONSHIP IS DIFFERENT. IN THE I-THOU RELATIONSHIP, WE SEE THE OTHER PERSON AS SOMEONE MADE IN THE IMAGE OF THE ALMIGHTY. WE SEE HIM OR HER AS AN EQUAL, AS A PARTNER, AS SOMEONE OF WORTH AND BEAUTY. WHEN WE TAKE ON THE RESPONSIBILITY OF OTHERS, WHEN WE CARE FOR THE STRANGER AND THE WEAK, WHEN WE TREAT THEM AS EQUALS, WE ENGAGE WITH THEM AS AN I-THOU. FROM THIS WE LEARN THAT WE ARE NOT JUST RESPONSIBLE FOR OURSELVES. WE ARE RESPONSIBLE FOR ALL WHO RESIDE IN OUR MIDST. THIS LESSON REMINDS US OF THE WORDS OF THE ANCIENT PROPHET ZECHARIAH, WHO DEMANDED THAT WE SHOULD EXECUTE TRUE JUSTICE, DEAL LOYALLY AND COMPASSIONATELY WITH ONE ANOTHER, DO NOT DEFRAUD THE WIDOW, THE ORPHAN, THE STRANGER AND THE POOR, AND DO NOT PLAN EVIL AGAINST ONE ANOTHER. WITH THE LIGHTS OF INDEPENDENCE STILL SHINING IN OUR EYES AND THE BOOMING SOUNDS OF FREEDOM STILL RINGING IN OUR EARS, LET US BEGIN OUR WORK THIS MORNING GUIDED BY ZECHARIAH'S MESSAGE. ETERNAL ONE, BLESS US THIS DAY SO THAT WE MAY HEED YOUR CALL AND EXECUTE TRUE JUSTICE THROUGHOUT YOUR LAND. WHEN FRUSTRATION AND EXHAUSTION OVERWHELM US, HELP US TO SUMMON OUR COMPASSION SO THAT WE MAY SEE OUR NEIGHBORS NOT AS FACELESS AND NAMELESS STATISTICS, BUT AS EQUALS, AS PARTNERS, AS FRIENDS. STRENGTHEN OUR VOICES SO THAT WE MAY SPEAK OUT FOR THOSE WHO HAVE BEEN SILENCED, MAKE FIRM OUR STEPS SO THAT WE MAY MARCH FOR JUSTICE, NOT AGAINST IT. AND HELP OUR EYES TO SEE THOSE WHO HAVE BEEN PUSHED ASIDE SO THAT WE MAY LEND THEM A HAND AND BRING THEM BACK INTO OUR COMMUNITY. (SPEAKING IN HEBREW). MAY WE COME IN PEACE AND MAY WE GO IN PEACE. AND LET US SAY AMEN. 

JOHN L. STAMATIADES: PLEASE FACE THE FLAG OF OUR GREAT NATION. THE PLEDGE OF ALLEGIANCE BEGIN. I PLEDGE ALLEGIANCE TO THE FLAG OF THE UNITED STATES OF AMERICA AND TO THE REPUBLIC FOR WHICH IT STANDS, ONE NATION, UNDER GOD, INDIVISIBLE, WITH LIBERTY AND JUSTICE FOR ALL. GOD BLESS AMERICA. 

SUP. KNABE, CHAIRMAN: SUPERVISOR YAROSLAVSKY? 

SUP. YAROSLAVSKY: MR. CHAIRMAN, THANK YOU. WE WERE LED IN THE INVOCATION THIS MORNING BY RABBI JOEL SIMONDS, WHO SERVES AS THE ASSISTANT RABBI AT UNIVERSITY SYNAGOGUE IN BRENTWOOD. RABBI SIMONDS WAS ORDAINED FROM THE HEBRIAN COLLEGE JEWISH INSTITUTE OF RELIGION JUST LAST MAY, TWO MONTHS AGO. WHILE IN RABBINICAL SCHOOL, RABBI SIMONDS SERVED AS A CHAPLAIN FOR THE U.C.L.A. MEDICAL CENTER AND HELPED DEVELOP A CLASS ON JEWISH SPIRITUALITY. RABBI SIMONDS RECEIVED HIS B.A. IN RELIGIOUS STUDIES FROM THE UNIVERSITY OF CALIFORNIA IN SANTA BARBARA. AND AFTER GRADUATING FROM THE UNIVERSITY, RABBI SIMONDS SPENT TWO YEARS WORKING FOR THE JEWISH COMMUNITY IN WASHINGTON, D.C. THANK YOU VERY MUCH, RABBI, FOR THOSE INSPIRATIONAL WORDS THIS MORNING. MOST RABBIS HAVE TO WAIT FIVE YEARS MINIMUM UNTIL THEY HAVE THE HIGH HONOR AND PRIVILEGE OF PRESENTING THE INVOCATION AT THE BOARD OF SUPERVISORS. YOU DID IT IN TWO MONTHS. CONGRATULATIONS, WELCOME. [APPLAUSE.] 

SUP. ANTONOVICH: LET ME ALSO ADD THAT THE RABBI IS THE FIRST RABBI BORN AND RAISED IN THE ANTELOPE VALLEY. HIS FATHER WAS A DISTINGUISHED EDUCATOR AT CORTSVILLE HIGH SCHOOL, THE HIGH SCHOOL THAT THE RABBI GRADUATED FROM, AND WAS A TEACHER TO MANY OF MY STAFF, BOTH DEPUTY AND CLERICAL IN THE ANTELOPE VALLEY. AND HIS MOTHER WENT TO SCHOOL WITH ZEV. SO IT'S A VERY SMALL WORLD AND WE WELCOME YOU HERE, AND THANK YOU FOR COMING DOWN. 

SUP. KNABE, CHAIRMAN: IT'S MY PLEASURE ON BEHALF OF SUPERVISOR MARK RIDLEY-THOMAS, WHO IS UNABLE TO BE HERE TODAY TO PRESENT A CERTIFICATE OF RECOGNITION TO MR. JOHN STAMATIADES, THE COMMANDER OF THE 17TH DISTRICT, AS I MENTIONED, AMERICAN LEGION, THE CITY OF LOS ANGELES. HE ALSO SERVES ON THE AMERICAN LEGION NATIONAL LEGISLATIVE COUNCIL. HE SERVED OUR COUNTRY IN THE UNITED STATES AIR FORCE FROM 1953 TO 1957 AS A MASTER SERGEANT WITH THE 261ST COMBAT COMMUNICATION SQUADRON. HE RECEIVED A U.S. AIR FORCE GOOD CONDUCT MEDAL, A U.S. AIR FORCE COMMENDATION MEDAL AND A NATIONAL DEFENSE SERVICE MEDAL. HE HAS LIVED IN SUPERVISOR RIDLEY-THOMAS'S DISTRICT SECOND DISTRICT FOR 33 YEARS. HE IS MARRIED, WITH TWO CHILDREN. SO ON BEHALF OF THE BOARD, WE'D LIKE TO THANK HIM FOR TAKING TIME OUT OF HIS SCHEDULE TO JOIN US HERE TODAY AND TO LEAD US IN THE PLEDGE OF ALLEGIANCE. [APPLAUSE.] YOU'RE LOOKING AT ME LIKE YOU WOULD LIKE TO CALL THE AGENDA. IS THAT CORRECT? ALL RIGHT, HERE WE GO. 

CLERK SACHI HAMAI: GOOD MORNING, MR. CHAIRMAN, MEMBERS OF THE BOARD. WE WILL BEGIN TODAY'S AGENDA ON PAGE 3, AGENDA FOR THE MEETING OF THE COMMUNITY DEVELOPMENT COMMISSION, ITEMS 1-D THROUGH 4-D. ON ITEM NO. 1-D, SUPERVISOR YAROSLAVSKY REQUESTS THAT THIS ITEM BE CONTINUED TWO WEEKS TO JULY 21ST, 2009. 

SUP. KNABE, CHAIRMAN: TWO WEEKS? 

CLERK SACHI HAMAI: TWO WEEKS. 

SUP. KNABE, CHAIRMAN: OKAY. SO ORDERED. 

CLERK SACHI HAMAI: ON ITEM NO. 3-D, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. SO ITEMS 2-D AND 4-D ARE BEFORE YOU. 

SUP. KNABE, CHAIRMAN: OKAY. MOVED BY SUPERVISOR ANTONOVICH. SECONDED BY SUPERVISOR YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: AGENDA FOR THE MEETING OF THE HOUSING AUTHORITY, ITEMS 1-H AND 2-H. ON ITEM NO. 1-H, THE EXECUTIVE DIRECTOR OF THE HOUSING AUTHORITY REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO JULY 14TH, 2009. 

SUP. KNABE, CHAIRMAN: SO ORDERED. 

CLERK SACHI HAMAI: ITEM 2-H IS BEFORE YOU. 

SUP. KNABE, CHAIRMAN: MOVED BY THE CHAIR. SECONDED BY SUPERVISOR YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: ONE WEEK, YES. BOARD OF SUPERVISORS ITEMS 1 THROUGH 9. ON ITEM NO. 1, THIS INCLUDES SUPERVISOR KNABE'S APPOINTMENT AS INDICATED ON THE SUPPLEMENTAL AGENDA. ON ITEM NO. 2, THIS RECOMMENDATION WAS REVISED AS INDICATED ON THE SUPPLEMENTAL AGENDA. ON ITEM NO. 3, SUPERVISOR RIDLEY-THOMAS REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO JULY 14TH, 2009. AND ON ITEM NO. 4, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. 

SUP. KNABE, CHAIRMAN: SO ITEM NO. 3 WILL BE CONTINUED TO JULY 14TH. 

CLERK SACHI HAMAI: CORRECT. AND THEN THE REMAINING ITEMS, INCLUDING ITEM NO. 1 AND 2 ARE BEFORE YOU. 

SUP. KNABE, CHAIRMAN: ON THE REMAINDER, THE CHAIR WILL MOVE IT, SECONDED BY SUPERVISOR ANTONOVICH. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: WE'RE NOW ON PAGE 9, CONSENT CALENDAR. ITEMS 10 THROUGH 33. ON ITEM NO. 10, THE AUDITOR-CONTROLLER REQUESTS THAT THIS ITEM BE CONTINUED TWO WEEKS TO JULY 21ST, 2009. 

SUP. KNABE, CHAIRMAN: SO ORDERED. 

CLERK SACHI HAMAI: ON ITEM NO. 11, AS INDICATED ON THE POSTED AGENDA, THE CHIEF EXECUTIVE OFFICER REQUESTS THAT THIS ITEM BE REFERRED BACK TO HIS OFFICE. 

SUP. KNABE, CHAIRMAN: SO ORDERED. 

CLERK SACHI HAMAI: ON ITEM NO. 12, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. 

SUP. KNABE, CHAIRMAN: SO ORDERED. 

CLERK SACHI HAMAI: ON ITEM NO. 14, SUPERVISOR KNABE REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO JULY 14TH, 2009. 

SUP. KNABE, CHAIRMAN: SO ORDERED. 

CLERK SACHI HAMAI: ON ITEM NO. 16, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. AND ON ITEM NO. 19, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. 

SUP. KNABE, CHAIRMAN: SO ORDERED. 

CLERK SACHI HAMAI: THE REMAINING ITEMS ARE BEFORE YOU. 

SUP. KNABE, CHAIRMAN: ON THE REMAINING ITEMS, MOVED BY SUPERVISOR ANTONOVICH. SECONDED BY SUPERVISOR YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: WE'RE NOW ON PAGE 18, ORDINANCES FOR INTRODUCTION. NO. 10 WAS CONTINUED TWO WEEKS. WE ARE ON PAGE 18, ORDINANCES FOR INTRODUCTION. ITEMS 34 THROUGH 41. ON ITEM NO. 34, SUPERVISOR KNABE REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO JULY 14, 2009. 

SUP. KNABE, CHAIRMAN: SO ORDERED. 

CLERK SACHI HAMAI: ON ITEMS NO. 35 THROUGH 41, THE AUDITOR-CONTROLLER REQUESTS THAT THESE ITEMS BE CONTINUED TO JULY 21ST, 2009. 

SUP. KNABE, CHAIRMAN: SO ORDERED. AND THERE IS NO TIMING ISSUE ON THAT, IS THAT CORRECT? 

CLERK SACHI HAMAI: CORRECT. 

SUP. KNABE, CHAIRMAN: OKAY. 

CLERK SACHI HAMAI: ON PAGE 19, SEPARATE MATTER ITEM 42, AND I'LL READ THE SHORT TITLE IN FOR THE RECORD. THIS IS THE TREASURER AND TAX COLLECTOR'S RECOMMENDATION TO ADOPT A RESOLUTION AUTHORIZING THE ISSUANCE AND SALE OF THE WEST SIDE UNION SCHOOL DISTRICT GENERAL OBLIGATION BONDS, 2008 ELECTION, SERIES A, IN AN AGGREGATE PRINCIPAL AMOUNT NOT TO EXCEED $20 MILLION. 

SUP. KNABE, CHAIRMAN: OKAY. MOVED BY THE CHAIR, SECONDED BY SUPERVISOR YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: ON PAGE 22, NOTICES OF CLOSED SESSION. ON ITEM NO. CS-1, SUPERVISOR RIDLEY-THOMAS REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO JULY 14TH, 2009. CS-1 ON PAGE 22. 

SUP. KNABE, CHAIRMAN: OKAY. SO ORDERED. 

CLERK SACHI HAMAI: AND THAT COMPLETES THE READING OF THE AGENDA, BOARD OF SUPERVISORS SPECIAL ITEMS BEGIN WITH SUPERVISORIAL DISTRICT NO. 1. 

SUP. KNABE, CHAIRMAN: WE HAVE A COUPLE OF SPECIAL PRESENTATIONS I'M GOING TO BEGIN WITH. FIRST OF ALL, ARE WE LIVE HERE NOW? ARE WE LIVE? WE ARE, OKAY. I'D LIKE TO INVITE UP THE HONORABLE JUKR BOON-LONG THE CONSUL GENERAL OF THAILAND HERE IN LOS ANGELES. CONSUL GENERAL BOON-LONG HAS BEEN THE HEAD OF THE CONSUL GENERAL HERE FOR THAILAND SINCE MAY OF 2006. HE HAS BEEN A CAREER DIPLOMAT SINCE 1984, WHEN HE JOINED THE THAI MINISTRY OF FOREIGN AFFAIRS. BEFORE THAT, HE EARNED A B.A. DEGREE IN LAW IN THAILAND, AN M.A. IN INTERNATIONAL POLITICS AND ECONOMICS FROM THE UNIVERSITY OF DETROIT HERE IN THE UNITED STATES. AS A DIPLOMAT, HE HAS SERVED THE ROYAL THAI EMBASSIES IN WASHINGTON, D.C., HANOI, AND BERLIN. HE HAS BEEN AWARDED NUMEROUS DECORATIONS, INCLUDING THE KNIGHT GRAND CROSS OF THE MOST NOBLE ORDER OF THE CROWN OF THAILAND. BEFORE HE BECAME CONSUL GENERAL HERE HE WAS DEPUTY DIRECTOR GENERAL OF THE DEPARTMENT OF INTERNATIONAL ECONOMIC AFFAIRS IN THE MINISTRY OF FOREIGN AFFAIRS IN THAILAND. IN HIS LOS ANGELES POST, CONSUL GENERAL BOON-LONG HAS BEEN RESPONSIBLE FOR THE PROVISION OF CONSULAR SUPPORT AND SERVICES TO AN ESTIMATED 300,000 PEOPLE, CONSIDERED THE LARGEST THAI POPULATION RESIDING OVERSEAS. UNDER HIS LEADERSHIP, THE ANNUAL THAI CULINARY TRAINING COURSE PROJECTS HAVE BEEN CONDUCTED IN COLLABORATION WITH MAJOR CULINARY INSTITUTES HERE ON THE WEST COAST. HE HAS ALSO PROMOTED THE THAI CULTURE ARTS AND CRAFTS THROUGH THE ANNUAL THAI FESTIVALS PROJECT AT FAIRS AND MAJOR CITIES. DURING HIS TENURE, HE DID SUCH A GOOD JOB THAT THEY EXPANDED HIS RESPONSIBILITY AND IT WENT FROM 8 TO 13 STATES. THE CONSUL GENERAL'S WIFE HAS ALSO BEEN VERY ACTIVE IN THE LOS ANGELES CONSULAR CORPS LADIES' ASSOCIATION. SO ON BEHALF OF OUR 10 MILLION PLUS RESIDENTS IN THE COUNTY OF LOS ANGELES AND THIS BOARD OF SUPERVISORS, WE BID CONSUL GENERAL JUKR BOON-LONG FAREWELL AS HE LEAVES HIS POST, WISH HIM CONTINUED SUCCESS AS HE RETURNS HOME TO BECOME THE MINISTER OF CULTURAL AFFAIRS. SO WE'RE MOST PROUD OF OUR WORKING RELATIONSHIP WITH CONSUL GENERAL BOON-LONG, WISH HIM AND HIS WIFE AND HIS FAMILY THE VERY, VERY BEST. A SAFE JOURNEY HOME. AND GODSPEED. [APPLAUSE.] 

JUKR BOON-LONG: THANK YOU VERY MUCH, MR. CHAIRMAN, FOR THE KIND WORDS OF INTRODUCTION. I JUST WANT TO THANK THE BOARD OF SUPERVISORS OF THE L.A. COUNTY FOR THE KIND GESTURE IN ARRANGING THIS BIDDING FAREWELL FOR ME. L.A. COUNTY IS VERY IMPORTANT TO THAILAND BECAUSE THIS COUNTY HOLDS THE LARGEST THAI COMMUNITY OVERSEAS. WE HAVE 100,000 THAI IN THIS L.A. COUNTY ALONE, AND THEY ARE ALL VERY HAPPY LIVING IN THIS COUNTY. I JUST WANT TO THANK THE L.A. COUNTY FOR THE KIND COOPERATION IT HAS EXTENDED TO MY OFFICE, THE OFFICE OF CONSULAR GENERAL OF THAILAND. AND THEN ALSO EXTENDED TODAY THE THAI COMMUNITY. AND I HOPE THAT THIS COOPERATION GOES ON. WE JUST CELEBRATE 175 YEARS OF THAI-U.S. RELATIONS. WE ARE THE CLOSEST ALLY OF UNITED STATES IN SOUTHEAST ASIA. SO THIS COOPERATION WILL GO ON IN THE FUTURE FOR THE BENEFIT OF OUR TWO COMMUNITIES. THANK YOU VERY MUCH. [APPLAUSE.] 

SUP. KNABE, CHAIRMAN: ALL RIGHT, ZEV, GLORIA? NEXT I'D LIKE TO INVITE UP THE ESTEEMED MEMBERS OF OUR COMMISSION ON JUDICIAL PROCEDURES. TODAY WE ARE CELEBRATING -- I THINK THIS IS THE FIRST TIME I'VE EVER DONE A SITUATION LIKE THIS. IT'S USUALLY A NUMBER OF YEARS. BUT THIS IS AN HONOR OF RECOGNITION OF THE 700TH MEETING OF THE JUDICIAL PROCEDURES COMMISSION. AND WE'RE FIGURING OUT, THAT'S PRETTY CLOSE TO 48 YEARS. SO THE COMMISSION ON JUDICIAL PROCEDURES WAS ESTABLISHED ON JUNE 6TH, 1961, TO MAKE RECOMMENDATIONS TO THE BOARD OF SUPERVISORS ON CHANGES AND IMPROVEMENTS IN JUDICIAL ADMINISTRATION. THESE IMPROVEMENTS HAVE PROVIDED FOR A SWIFTER, MORE EFFICIENT AND A MORE ECONOMICAL JUSTICE SYSTEM, REDUCED CASELOADS AND DELAYS FOR LITIGANTS IN THE SUPERIOR COURT. THIS COMMISSION ALSO DETERMINES THE NEED FOR ADDITIONAL JUDGES AND MAKES RECOMMENDATIONS FOR ACTION BY THE BOARD ON LEGISLATION PERTAINING TO THE SUPERIOR COURT. IT OBVIOUSLY ALSO FACILITATES THE RELATIONSHIP BETWEEN THE COURT AND THE COUNTY. THIS COMMISSION REMAINS ON THE FOREFRONT, WORKS FIRMLY TO IMPROVE THE QUALITY AND SERVICES AND PROGRAMS OFFERED BY THE COURTS TO THE CITIZENS OF OUR GREAT COUNTY. THEY MEET DILIGENTLY ON THE SECOND THURSDAY OF EVERY MONTH. THEY HAVE MET FOR 700 TIMES. OH, THE -- HERE. SO ON BEHALF OF THE BOARD, WE WANT TO PRESENT THIS SCROLL TO THE COMMISSION IN RECOGNITION OF ITS 700TH MEETING ANNIVERSARY. BUT ALSO JUST TO THANK THEM FOR THEIR EXCEPTIONAL SERVICE AND DEDICATION TO THE IMPROVEMENTS OF THE SERVICES TO THE CITIZENS AND TO OUR COURT SYSTEM. SO CONGRATULATIONS. LET'S GIVE THEM A BIG ROUND OF APPLAUSE. [APPLAUSE.] MR. CHAIRMAN, WOULD YOU LIKE TO SAY A FEW WORDS HERE BEFORE WE GIVE YOU A SCROLL? 

SPEAKER: THANK YOU, SUPERVISOR KNABE. AND ON BEHALF OF THE COMMISSION, WE APPRECIATE THIS ACKNOWLEDGMENT. OVER THE YEARS, MANY PEOPLE HAVE SERVED ON THIS COMMISSION, JUDICIAL PROCEDURES COMMISSION, AND OFTENTIMES THERE ARE OPENINGS. AND IF PEOPLE ARE INTERESTED, CONTACT YOUR SUPERVISOR, THEY'RE THE ONES THAT MAKE THE APPOINTMENTS TO THE JUDICIAL PROCEDURES COMMISSION. AND WE'RE CONCERNED WITH CHILD CENTERS FOR THE COURTS. WE'RE CONCERNED WITH ANYTHING TO DO WITH THE COURT SYSTEM IN THE COUNTY OF LOS ANGELES. AND ON BEHALF OF THE COMMISSIONERS THAT ARE PRESENT THIS MORNING, WE APPRECIATE THIS ACKNOWLEDGMENT. WE WILL CONTINUE TO MOVE FORWARD TO HELP MAKE OUR COURT SYSTEM MORE PRODUCTIVE, MORE EFFECTIVE FOR THE PEOPLE OF THE GREAT LOS ANGELES COUNTY. THANK YOU. [APPLAUSE.] 

SUP. KNABE, CHAIRMAN: NOW IT IS MY EXTREME PLEASURE TO INTRODUCE THE JULY 2009 L.A. COUNTY STARS, STARS IN THE CATEGORY OF SERVICE EXCELLENCE AND ORGANIZATIONAL EFFECTIVENESS. BEAD' LIKE TO WELCOME KATHY HESTER-FLANAGAN, A MENTAL HEALTH COORDINATOR 2 FROM THE DEPARTMENT OF MENTAL HEALTH. OBVIOUSLY THE GOALS OF THE CENTRAL JUVENILE HALL MENTAL HEALTH PROGRAM ARE TO ENRICH THE LIVES OF THE INCARCERATED YOUTH BY PROVIDING CARING, EFFECTIVE AND CULTURALLY RESPONSIVE MENTAL HEALTH SERVICES TO AN UNDERSERVED POPULATION IN ORDER TO ALLOW THEM THE OPPORTUNITY TO FULFILL THEIR GOALS. KATHY EFFECTIVELY SUPPORTS AND ENHANCES THESE GOALS IN THE WORK THAT SHE PERFORMS AS A MENTAL HEALTH COORDINATOR AND RECREATIONAL THERAPIST. HER WORK ADDS AN INVALUABLE ASPECT TO THE TRADITIONAL PSYCHOTHERAPEUTIC SERVICES FOR OUR YOUTH WITH A FOCUS ON THE DEVELOPMENT AND THE EMPOWERMENT AS A WHOLE PERSON. SHE ACHIEVES THIS BY HER ARTS PROGRAMMING AND COORDINATION OF ACTIVITIES THAT HAVE BEEN SHOWN OVER THE YEARS TO REDUCE BEHAVIOR PROBLEMS, PROMOTE COOPERATION, PROMOTE PRO-SOCIAL SKILL DEVELOPMENT, ENCOURAGE SCHOOL ATTENDANCE. SHE HAS DEVELOPED VERY POSITIVE COLLABORATIVE PARTNERSHIPS WITH THE PROBATION DEPARTMENT, INCLUDING LINE STAFF IN LIVE-IN WARD UNITS AND WITH PERFORMING ARTISTS BY CONSISTENTLY INVOLVING THEM IN THE COLLABORATION AND ENGAGEMENT FOR THE BENEFIT OF THE YOUTH. HER WAY OF COORDINATING WITH THE JUVENILE HALL ADMINISTRATION PROBATION STAFF, MENTAL HEALTH CLINICAL STAFF, AND THE PARTICIPATING ARTISTS OF THE ART, SOCIAL, MULTICULTURAL, ACADEMIC, RECREATIONAL, THERAPEUTIC, BETTER KNOWN AS SMART, AND THE YOUTH CHOSEN TO BE IN THE PROGRAM ALLOWS FOR THIS PROGRAM TO MOVE SMOOTHLY THROUGH THE JUVENILE HALL IN A CONSISTENT AND CONSTANTLY CHANGING FIVE-WEEK WORKSHOP SESSION. HER DEDICATION TO EXCELLENCE HAS CONTRIBUTED TO SMART BEING THE RECIPIENT OF A PRODUCTIVITY AND QUALITY AWARD, AN ACHIEVEMENT GIVEN BY THE NATIONAL ASSOCIATION OF COUNTIES, NACO, IN 2008. SO WE WANT TO SAY THANK YOU AND CONGRATULATIONS TO KATHY HESTER-FLANAGAN. [APPLAUSE.] 

KATHY HESTER-FLANAGAN: GOOD MORNING, EVERYONE. I JUST WANT TO SAY A FEW WORDS. I ACCEPT THIS HONOR ON BEHALF OF MY DEPARTMENT AND BEHALF OF MY PROGRAM HEAD, DR. SHIRLEY FLOURNOY, AND ALL OF THE PROFESSIONAL MEN AND WOMEN THAT I WORK WITH AT CENTRAL JUVENILE HALL, BOTH IN THE MENTAL HEALTH DEPARTMENT AND PROBATION. AND I WANT TO ALSO THANK THE PROFESSIONAL ARTISTS THAT I WORK WITH. THEY'RE VERY GIFTED IN THE "ART SMART" PROGRAM, AND THE AMAZINGLY TALENTED YOUTH THAT ARE AT CENTRAL JUVENILE HALL. SO ON BEHALF OF ALL OF THEM WHO HELP MAKE MY JOB SO MUCH EASIER, I ACCEPT THIS AWARD. THANK YOU SO VERY MUCH. [APPLAUSE.] 

DR. MARVIN J. SOUTHARD: I WANT TO GIVE MY CONGRATULATIONS TO KATHY AND THE "ART SMART" PROGRAM. THIS IS A PROGRAM THAT JUST DOESN'T MERELY SOUND GOOD. IT SOUNDS GOOD TO INVOLVE YOUTH IN THE ARTS. BUT ONE OF THE THINGS WE FOUND IN OUR PARTNERSHIP WITH PROBATION IS THAT IT ACTUALLY WORKS TO IMPROVE THE BEHAVIOR OF THESE YOUNG PEOPLE AND GIVE THEM SOMETHING. AND SO IT'S SOMETHING NOT JUST FOR THE HALL BUT ALSO FOR THEIR DEVELOPMENT WHEN THEY LEAVE THE HALL. SO WE CONSIDER THIS AS REALLY ONE OF THE BEST EVIDENCE-BASED PRACTICES WE HAVE ABOUT IMPROVING THE LIVES OF THESE YOUNG PEOPLE. AND I'M SO PROUD THAT OUR DEPARTMENT HAS BEEN ABLE TO DEVELOP THIS. SO THANK YOU VERY MUCH. [APPLAUSE.] 

SUP. KNABE, CHAIRMAN: GLORIA? 

SUP. MOLINA: THANK YOU, MR. CHAIRMAN. I'M GOING TO BRING UP A WHOLE GROUP OF FOLKS. I VERY RARELY BRING UP THIS MANY FOLKS TO RECEIVE ACKNOWLEDGMENT AND PRESENTATIONS, BUT I THINK IT'S VERY ESSENTIAL FOR THIS PARTICULAR PROGRAM. YOU KNOW, IT'S BEEN ABOUT A YEAR AND ALMOST TWO YEARS THAT WE STARTED AND CREATED THE FIRST DISTRICT EDUCATIONAL PILOT PROGRAM. AND IT'S BEEN A TREMENDOUS SUCCESS. EARLIER TODAY WE HAD A LITTLE GATHERING OUT IN THE PATIO, AND WE HAD THE OPPORTUNITY TO PRESENT SCROLLS TO ALL OF THE FOSTER CARE KIDS THAT HAVE PARTICIPATED IN THIS PROGRAM, AND SOME OF THEM WHO HAVE WORKED SO VERY HARD AND WEREN'T SCHEDULED TO GRADUATE, AND 19 OF THEM WHO HAVE GRADUATED FROM HIGH SCHOOL THIS PAST JUNE. WE ARE VERY, VERY PROUD OF THEM. AS ALL OF US KNOW, PLACEMENT IN FOSTER CARE IS ONE OF THE MOST DISTRESSING EVENTS THAT CAN HAPPEN TO ANY CHILD. HE OR SHE IS OFTEN FORCED TO CHANGE SCHOOLS, SOMETIMES REPEATEDLY, DURING THE COURSE OF ANY OF THEIR PLACEMENTS. AND ADDRESSING EDUCATIONAL ISSUES FOR FOSTER YOUTH, AS WE ALL KNOW, IS AN ONGOING CHALLENGE. AND AS COUNTY SUPERVISORS, WE ALL RECOGNIZE AND UNDERSTAND THAT DIRECTLY IT IS OUR RESPONSIBILITY AS THESE KIDS ARE OUR WARDS. IN THE SPRING OF 2008, OUR OFFICE SPEARHEADED THE EDUCATIONAL PILOT PROGRAM TO IMPROVE THE EDUCATIONAL OUTCOMES FOR MANY OF THESE FOSTER CARE KIDS. WE CREATED THE TOOLS TO ASSESS WHERE OUR YOUTH WERE AT, WHERE THEY STOOD EDUCATIONALLY, AND DEVELOPED A CASE PLAN ADDRESSING ALL OF THEIR NEEDS. WE COLLABORATED WITH THE DEPARTMENT OF CHILDREN SERVICES, THE C.E.O.'S STAFF. WE WERE VERY FORTUNATE TO HAVE TWO VERY COOPERATIVE SCHOOL DISTRICTS, POMONA UNIFIED SCHOOL DISTRICT, AND THE MONTEBELLO UNIFIED SCHOOL DISTRICTS. THEY, ALONG WITH THE CASEY PROGRAMS AND OUR LOS ANGELES COUNTY EDUCATIONAL COORDINATING COUNCIL, REALLY DEVELOPED THE POLICIES, THE PROCEDURES, WENT THROUGH A WHOLE PROCESS TO MAKE SURE THAT WE HAD THE VERY BEST PROGRAM IN PLACE. OUR PROCESS REVEALED THAT OFTEN MANY OF THESE STUDENTS HAD TAKEN IN PAST COURSES IN THE PAST. BUT AS THEY WERE MOVED FROM SCHOOL TO SCHOOL, MANY OF THOSE CREDITS WERE NOT ATTACHED TO THOSE KIDS AND THOSE CREDITS WERE LOST. THANKS TO THE INTENSIVE ATTENTION PROVIDED BY OUR SOCIAL WORKERS, THOSE CREDITS WERE NOT ONLY FOUND BUT THEY WERE RESTORED TO MANY OF THESE KIDS THAT HAD ALREADY COMPLETED THOSE CLASSES. AND WE'RE ALSO GRATIFIED THAT MANY OF OUR KIDS FROM HERE ARE GOING TO GO ON AND ENROLL IN COLLEGE. THE PILOT PROGRAM HAS REALLY STRENGTHENED THE RELATIONSHIP BETWEEN THE DEPARTMENT OF CHILDREN SERVICES AND MANY OF OUR SCHOOL DISTRICTS, AS WELL AS THE CAREGIVERS WHO ARE RESPONSIBLE FOR THEM EVERY SINGLE DAY, TO HAVE A BETTER UNDERSTANDING OF HOW TO NAVIGATE THROUGH THE EDUCATIONAL SYSTEM, WHICH CAN BE QUITE DIFFICULT. I APPLAUDED THEM EARLIER THIS MORNING. I WANT TO APPLAUD THEM AGAIN BECAUSE THEY HAVE DONE AN OUTSTANDING JOB. AND I'M PARTICULARLY PROUD OF THE STUDENTS BECAUSE MANY OF THEM HAD SORT OF GIVEN UP. MANY OF THEM THOUGHT THIS IS JUST THE WAY THE SYSTEM WORKS. BUT I THINK THEY, TOO, WERE INSPIRED AND MOTIVATED BY THE CAREGIVERS, BY THE SOCIAL WORKERS, BY THE COUNSELORS AND ALL THE PEOPLE THAT WERE INVOLVED THAT REALLY INSPIRED THEM TO MOVE FORWARD. IN HEARING THE STORIES OF EACH OF THESE STUDENTS, IT'S BEEN IMPRESSIVE THE KIND OF ATTENTION THAT THEY'VE RECEIVED FROM EVERYONE. AND I THINK IT'S ATTENTION THAT ALL OF US TAKE FOR GRANTED THAT SHOULD BE THERE ON THEIR BEHALF. IN MANY INSTANCES, IT IS NOT. SO I APPLAUD MANY OF THE PEOPLE WHO ARE SO VERY ATTENTIVE IN WORKING THIS ALL OUT. THERE'S A LOT OF PEOPLE TO THANK AND TO APPRECIATE. AND I REALLY WANT TO TAKE THE TIME TO GIVE THEM RECOGNITION BECAUSE THEY DESERVE OUR RECOGNITION. ONE OF THE KEY LEADERS OF THIS PROGRAM AND PROCESS WAS A JUDGE THAT IS FAMILIAR TO ALL OF US. HE'S NOT HERE THIS MORNING BECAUSE HE HAD TO GET BACK TO WORK, BUT HE ATTENDED OUR MORNING RECEPTION, AND THAT'S JUDGE NASH. AS WE ALL KNOW, JUDGE NASH HAS AN UNBELIEVABLE TASK AHEAD OF HIM IN TRYING TO FIGURE OUT THE BEST INTERESTS OF CHILDREN EVERY SINGLE DAY, EVERY SINGLE MOMENT. WHEN WE APPROACHED HIM ABOUT THIS PROGRAM, HE WAS VERY, VERY SUPPORTIVE, AND BASICALLY HAS HELPED US CLEAR THE PATH SO THAT AS WE ALL KNOW, WHETHER IT'S A BUREAUCRACY OR LAWS THAT DON'T ALLOW YOU TO HAVE ACCESS TO RECORDS AND INFORMATION THAT YOU NEED IN ORDER TO PLAN THE SUCCESS OF A CHILD, JUDGE NASH WAS INSTRUMENTAL IN HELPING US PUT THAT FORWARD. AND I REALLY WANT TO THANK HIM FOR HIS LEADERSHIP. AND I THINK MANY OF US REALLY RESPECT THE KIND OF ROLE THAT HE UNDERTAKES AND MANAGES AS HE CARRIES OUT HIS WORK AS A PRESIDING JUDGE OF OUR DEPENDENCY COURT. SO WE PRESENTED HIM WITH A SCROLL A LITTLE EARLIER. SOMEONE WHO'S BEEN REALLY HELPFUL IN THIS REGARD AND HAS HAD TO TAKE A LOT OF GRIEF FROM ME FROM TIME TO TIME AS THIS WAS CARRIED OUT, BECAUSE THERE'S JUST SO MANY PROCEDURES AND POLICIES THAT NEED TO BE CHANGED AND CHALLENGES THAT NEED TO BE MADE TO HER AND HER SUPERVISING STAFF, AND THAT'S OUR VERY OWN TRISH PLOEHN. SHE HAS, AS THE LEADER OF OUR DEPARTMENT OF CHILDREN SERVICES, WHERE ARE YOU, TRISH? 

TRISH PLOEHN: RIGHT HERE. 

SUP. MOLINA: SHE HAS PROVIDED GREAT LEADERSHIP. AND I WANT TO THANK HER. SHE IS VERY DESERVING. SHE HAS MADE AN UNBELIEVABLE AMOUNT OF CHANGES WITHIN THAT DEPARTMENT TO REALLY FOCUS ON GETTING SOCIAL WORKERS TO NOT ONLY BE ATTENTIVE TO THESE CHILDREN BUT MORE IMPORTANTLY, TO CHALLENGE THEMSELVES AS TO HOW THEY NAVIGATE THE EDUCATIONAL SYSTEM. AND I THANK HER FOR ALL OF HER SUPPORT THROUGHOUT IT. CONGRATULATIONS, TRISH. [APPLAUSE.] DO YOU WANT TO SHARE A FEW WORDS? OKAY. TAKING A PICTURE. ALL RIGHT. WOULD YOU? 

TRISH PLOEHN: THANK YOU VERY MUCH. I JUST WANTED TO SHARE WITH YOU THAT IT IS TRULY BECAUSE OF SUPERVISOR MOLINA'S UNWAVERING BELIEF IN THE IMPORTANCE OF EDUCATION FOR ALL CHILDREN THAT WE ARE HERE TODAY. SINCE THE INCEPTION OF THIS FIRST DISTRICT EDUCATIONAL PILOT, MY STAFF, MY MANAGERS, MY STAFF HAVE REALLY GOT THE OPPORTUNITY TO FEEL THE IMPORTANCE OF WHAT IT IS TO TREAT THE WHOLE CHILD. AS THE DEPARTMENT, IT HAS ALWAYS BEEN OUR RESPONSIBILITY TO ENSURE A CHILD'S SAFETY. AND THAT'S VERY IMPORTANT. BUT SAFETY IS JUST ONE PIECE OF WHAT A CHILD NEEDS. A CHILD NEEDS PERMANENT FAMILIES. A CHILD NEEDS A SENSE OF BELONGING. A CHILD NEEDS SELF-ESTEEM AND SELF-RESPECT. AND THAT'S WHAT EDUCATION GIVES THEM. THE 19 GRADUATES THAT WE HAVE, WE ARE SO VERY PROUD OF THEM. AND WHAT WE ARE GOING TO DO IS TO USE WHAT WE HAVE LEARNED FROM THIS PROGRAM THIS YEAR TO ENSURE THAT WE CAN TAKE THESE TYPES OF SUCCESSES SO THAT THE CHILDREN IN THE FUTURE AND IN THE CHILD WELFARE SYSTEM, IN OUR EDUCATIONAL SYSTEM, ARE ALL GOING TO BENEFIT FROM WHAT WE'VE LEARNED THIS YEAR. AND I DO WANT TO HAVE A FEW SPECIAL THANK YOUS, BECAUSE MARTHA MOLINA AVELES, OVER THERE, HAS JUST BEEN INSTRUMENTAL. SHE'S ONE OF SUPERVISOR MOLINA'S CHILDREN'S DEPUTIES. AND SHE HAS BEEN INSTRUMENTAL IN MAKING SURE THAT THIS PROGRAM WORKED, AS WELL AS CARRIE MILLER FROM THE EDUCATION COORDINATING COUNCIL, JENNY SORANO, FROM THE CHIEF EXECUTIVE OFFICE. ALL OF THE BOARD MEMBERS, ALL OF THE D.C.F.S. STAFF, IT REALLY TAKES EVERYBODY TO MAKE SOMETHING LIKE THIS SUCCESSFUL FOR OUR YOUNG PEOPLE. AND MOSTLY, I JUST WANT TO CONGRATULATE THE YOUNG PEOPLE THAT HAVE ACHIEVED SO MUCH. WITH A LITTLE BIT OF ATTENTION AND A LITTLE BIT OF SUPPORT, THEY HAVE DONE MIRACULOUS THINGS THIS YEAR, AND WE'RE VERY, VERY PROUD OF THEM. THANK YOU SO MUCH. 

SUP. MOLINA: THANK YOU, TRISH. THE SUCCESS OF THIS PROGRAM WAS REALLY BEEN BASED ON THE COOPERATION OF HAVING SCHOOL DISTRICTS WORK WITH YOU. IT WAS INTERESTING, WHEN WE FIRST APPROACHED L.A. UNIFIED ABOUT WORKING WITH US, THEY REALLY WEREN'T INTERESTED AT ALL. AND NOW THAT THEY'VE SEEN THE SUCCESS OF THE PROGRAM, NOW ALL OF A SUDDEN, THEY'RE VERY INTERESTED IN WORKING WITH US. BUT WILLING TO STEP UP AND ALLOW US TO COME IN AND LOOK AT THEIR RECORDS AND TALK ABOUT HOW THEY WERE DOING THEIR PROGRAM AND WHAT THEY WERE DOING AND IF THEY KNEW HOW MANY FOSTER CARE KIDS THEY HAD IN THEIR WHOLE SCHOOL, IT CAN BE VERY CHALLENGING TO ANYONE BECAUSE THEY'RE SO -- THEY HAVE SO MANY RESPONSIBILITIES IN TRYING TO EDUCATE OUR KIDS, TRYING TO MANAGE THEIR LIMITED RESOURCES, TRYING TO CARRY OUT THEIR ROLES EVERY SINGLE DAY, THAT FOR US TO COME IN WAS ANOTHER ISSUE. BUT I THINK THAT THE SCHOOL DISTRICT HAS CERTAINLY BENEFITED. WE HAVE BENEFITED FROM THEIR ABILITY TO WORK WITH US. AND IN THE LONG RUN, THEY ARE GOING TO BE HELPFUL TO US AS TO HOW WE INTRODUCE THIS PROGRAM INTO VARIOUS SCHOOL DISTRICTS. AND I WANT TO CONGRATULATE FIRST OF ALL EDWARD VELASQUEZ. COME UP AND JOIN ME. WHEN I CALLED HIM THE FIRST TIME, I THINK I FREAKED HIM OUT COMPLETELY. [APPLAUSE.] BUT I WANT TO THANK HIM BECAUSE THEY'VE BEEN INSTRUMENTAL IN LENDING THEIR PERSONNEL, IN ALLOWING US TO GO THROUGH THE PROCESS OF THE RECORDS, GETTING A LOT OF THAT INFORMATION, AND I WANT TO THANK HIM. HE IS THE SUPERINTENDENT AT MONTEBELLO SCHOOL DISTRICT, AND WE'RE SO VERY PROUD OF HIM. CONGRATULATIONS AND THANK YOU FOR YOUR LEADERSHIP, SIR. THANK YOU. WE REALLY APPRECIATE IT. JOINING ME IN THAT EFFORT WAS THE SUPERINTENDENT FROM THE POMONA UNIFIED SCHOOL DISTRICT, AND OF COURSE THAT IS THELMA MELENDEZ DE SANTA ANA IS HER FULL NAME. SHE IS GOING ON TO BE AN ASSISTANT SECRETARY AT THE DEPARTMENT OF EDUCATION UNDER THE OBAMA ADMINISTRATION. AND SHE'S ON HER WAY THERE, SO SHE WASN'T ABLE TO JOIN US. BUT HER VERY ABLE ASSISTANT SUPERINTENDENT IS HERE. AND I WANT TO BRING HIM UP BECAUSE HE WAS ALSO A PART OF THAT ANSWER AND HELPING US THROUGH ALL THOSE BARRIERS, AND THAT'S MR. RICHARD MARTINEZ. MUCHISIMAS GRACIAS. THANK YOU. YOU DID AN OUSTANDING JOB. AND THANK THELMA FOR US. THANK YOU. YOU KNOW, ALONG THE WAY, THERE'S A WHOLE LOT OF FOLKS THAT WORK ON ALL OF THESE ISSUES. AND THEY ARE INSTRUMENTAL IN GETTING IT DONE. YOU KNOW, ONE OF THE THINGS THAT WE HAVE TAKEN OUT, AS WELL, FROM OUR EDUCATIONAL SYSTEM IS OUR COUNSELORS. YOU KNOW, WE THINK THAT "WELL, YOU DON'T NEED THEM. YOU JUST NEED THE EDUCATORS IN THE CLASSROOM." BUT IT'S THE COUNSELORS THAT REALLY TALK TO THE KIDS, TO HELP THEM SORT IT OUT, HAVE THAT INDIVIDUAL ATTENTION. AND WE WANT TO ACKNOWLEDGE THEM, AS WELL, BECAUSE THEY DID AN OUTSTANDING JOB. SO FROM THE MONTEBELLO SCHOOL DISTRICT, WE HAVE PATRICIA LOPEZ, PATTI LOPEZ, A FRIEND OF MINE, WHO WAS A COUNSELOR THERE. CONGRATULATIONS, PATTI. [APPLAUSE.] AND FROM THE POMONA SCHOOL DISTRICT, WE HAD ZOILA MONETTE? AM I PRONOUNCING IT? CONGRATULATIONS. GOOD JOB. OH, I'M SO GLAD YOU HAD A GOOD JOB WITH IT. YOU DID GREAT. WE THANK THEM FOR THEIR ATTENTION ON THAT. NOW, OUR OWN CHILDREN SERVICES WORKERS, MARTHA AND I WERE RELENTLESS WITH THEM. AND THEY TOOK A LOT OF GRIEF FROM US. BUT I THINK THEY WERE SO HELPFUL TO US TO FIGURE OUT -- YOU KNOW, WE ALL THINK THAT THE DEPARTMENT OF CHILDREN SERVICES IS A DEPARTMENT THAT'S THERE TO TAKE CARE OF THE KIDS. AND OBVIOUSLY, THAT'S WHAT WE ASSUME AND WE THINK. BUT VERY, FRANKLY, THEY'RE THERE TO PROTECT THE CHILDREN FROM ABUSE AND NEGLECT. AND SOMETIMES THESE ADDITIONAL SERVICES THAT WE THINK OR TAKE FOR GRANTED ARE REALLY NOT IN PLACE. AND THEY REALLY ASSISTED US AT TRYING TO FIGURE OUT HOW TO CONNECT IT AND HOW TO MAKE IT WORK. AND I REALLY THANK THEM FOR THEIR LEADERSHIP AND THE WORK THAT THEY DID IN HELPING US SORT OUT THE WHOLE SYSTEM. ONE OF THOSE INDIVIDUALS, MARIANNE FATIMI, WHO IS NOW OUR DEPUTY DIRECTOR, SO CONGRATULATIONS. THANK YOU FOR YOUR LEADERSHIP. I REALLY APPRECIATE IT. YOU DID A GOOD JOB. THANK YOU. ANOTHER ONE OF THOSE INDIVIDUALS THAT WAS ONE OF THE SUPERVISORS THAT WAS THERE IS ANGEL RODRIGUEZ. ANGEL, THANK YOU. THANK YOU. AND ALSO ONE OF OUR SOCIAL WORKERS THAT WAS OUT THERE WHO ALWAYS WAS VERY HELPFUL, AND THAT'S ARLENE BARIOS. THANK YOU. WE REALLY APPRECIATE YOUR HELP. [APPLAUSE.] AND ELVA MENDEZ WAS OUR OTHER SOCIAL WORKER. CONGRATULATIONS. THANK YOU. [APPLAUSE.] NOW, ALL OF THAT WAS UNDER A WHOLE TEAM THAT WAS PUT TOGETHER IN THE C.E.O.'S OFFICE. THEY WORKED DILIGENTLY WHEN MARTHA AND I WEREN'T WORKING WITH THEM EVERY SINGLE DAY, BUT THEY DID AN OUTSTANDING JOB IN CONNECTING SO MANY OF THE SILOS THAT WE HAVE, UNFORTUNATELY, UNDER A BUREAUCRACY. I WANT TO THANK MIGUEL SANTANA. I DON'T KNOW IF HE'S HERE TODAY, BUT THROUGH HIS LEADERSHIP, WE WERE ABLE TO OVERCOME A LOT OF THE OBSTACLES AND THE BARRIERS THAT WERE THERE. BUT I PARTICULARLY WANT TO THANK ALSO HIS STAFF. AND THAT'S JENNY SERANO AND CARRIE MILLER. WHERE ARE THEY? CONGRATULATIONS. [APPLAUSE.] JENNY, THANK YOU. CARRIE. COULD WE TAKE A PICTURE? AND FINALLY, WE GIVE CERTIFICATES TO ALL OF THE KIDS. THEY HAVE DONE SUCH AN OUTSTANDING JOB. THEY HAVE BEEN VERY DEDICATED. AND WHEN YOU HEAR THEIR STORIES AND ALL THE DIFFERENT STORIES, YOU FIND OUT THAT THEY REALLY NEEDED THAT LITTLE EXTRA BOOST. ON THEIR OWN, THEY'RE VERY BRIGHT, VERY CAPABLE AND VERY SMART. BUT SOMETIMES, THE SYSTEM DOES WEAR YOU DOWN WHEN YOU'RE MOVED FROM PLACE TO PLACE, YOU'RE CHANGED FROM SCHOOL TO SCHOOL, YOU KNOW HOW OVERWHELMING THAT CAN BE. BUT THEY WERE SUCCESSFUL. SO MANY OF THEM HAVE GRADUATED, SO MANY OF THEM ARE GOING TO GRADUATE, AND SOME OF THEM ARE GOING ON TO COLLEGE. SO WE'RE VERY PROUD OF THEM AND SO WE'RE VERY PROUD OF THIS VERY FIRST CLASS. SO LET ME BRING UP THE STUDENT SPEAKER WHO IS GOING TO SPEAK ON BEHALF OF ALL THE STUDENTS AND IS IT JEANETTE? COME ON UP. OH, YOU'RE GOING TO SPEAK. 

SPEAKER: GOOD MORNING, EVERYBODY. THE IMPORTANCE OF THIS PROGRAM IS EVIDENT IN EVERY CHILD'S FACE. IT HAS NOT ONLY OPENED DOORS OF POSSIBILITIES FOR A BRIGHTER FUTURE IN THIS VERY UNSTABLE SOCIETY THAT WE HAVE NOW, BUT IT HAS EMPOWERED US TO ACT MORE AS STRONG INDIVIDUALS AND STUDENT LEADERS. THIS PROGRAM HAS PERSONALLY HELPED ME OBTAIN CREDITS TO RECEIVE MY HIGH SCHOOL DIPLOMA. I WAS BEHIND JUNIOR YEAR, AND MY FORMER LIAISONS WERE EVITA SALAS AND PATRICIA BURGETT. AND THEY HELPED ME A LOT THROUGHOUT THIS JOURNEY. THEY HELPED ME REACH MY GOALS. AND THE MOST IMPORTANT THING I LEARNED IS THAT I CAN REACH EVERYTHING I BELIEVE IN. I ALSO GOT AN INTERNSHIP THROUGH R.O.P. PROGRAM, WHICH HELPED ME GET HANDS-ON TRAINING THROUGH WELLS FARGO AT A BANKING PROGRAM. IN TERMS OF MY FUTURE, IT HAS HELPED ME REALIZE THAT MY DREAMS HAVE BECOME REALITY. I HAVE GRADUATED WITH MY CLASS AND I WAS BEHIND. I DIDN'T THINK THAT WAS POSSIBLE. FROM THE DREAM THAT I HOPED, I DISCOVERED MY TALENT IN WRITING THROUGH THE ENCOURAGEMENT OF STAFF MEMBERS FROM THIS PROGRAM. I HAVE DECIDED TO MAJOR IN ENGLISH FROM ALL YOU GUYS HELPING ME OUT. AND I'D LIKE TO THANK EVERYBODY HERE FOR HELPING THIS COME TOGETHER. AND OF COURSE, GLORIA MOLINA. 

SUP. MOLINA: THANK YOU, SWEETHEART. THANK YOU. [APPLAUSE.] WE ARE PROUD OF EVERY SINGLE ONE OF THEM. THEY DID AN OUTSTANDING JOB. MAY I ASK A SPECIAL THANKS TO MARTHA MOLINA OF MY OFFICE WHO HAS DONE AN OUTSTANDING JOB, AS WELL. CONGRATULATIONS, MARTHA. [APPLAUSE.] IT IS OUR HOPE THAT THIS PILOT PROGRAM WILL EVENTUALLY BE PLACED DIRECTLY INTO OUR PROGRAMMING OF WHAT WE DO. THE CASEY FOUNDATION IS WORKING WITH US NOW, DAVID SAUNDERS, OUR FORMER DIRECTOR, HAS BEEN INVOLVED WITH THIS. AND HE HAS HAD HIS REPRESENTATIVE HERE, AS WELL. AND WE HOPE THAT EVENTUALLY THIS IS A PROGRAM THAT IS GOING TO BE AVAILABLE TO EVERY SINGLE FOSTER CARE CHILD THAT IS WITH US BECAUSE THEY DESERVE IT. AS YOU CAN SEE, THESE ARE BRIGHT, TALENTED, WONDERFUL YOUNG PEOPLE. AND WE NEED TO DO ALL WE CAN TO GIVE THEM THAT BOOST THAT THEY NEED TOWARD THEIR INDEPENDENCE TO REALLY CREATE AN EMANCIPATION THAT WILL TRULY MAKE THEM THE FUTURE LEADERS THAT WE WANT TO SEE. SO WE CONGRATULATE EVERYONE WHO WAS INVOLVED. THANK YOU SO VERY MUCH. CONGRATULATIONS. [APPLAUSE.] COULD I ASK SOME OF THE OTHER STUDENTS THAT ALL GRADUATED, IF COULD THEY PLEASE STAND? THEY DESERVE A ROUND OF APPLAUSE. COULD YOU PLEASE STAND? [APPLAUSE.] PLEASE STAND. THANK YOU FOR BEING HERE. WE APPRECIATE IT. 

SUP. KNABE, CHAIRMAN: SUPERVISOR YAROSLAVSKY? SUPERVISOR ANTONOVICH? 

SUP. ANTONOVICH: WELL, THIS IS A SAD DAY FOR THE COUNTY AND A VERY HAPPY DAY FOR THE COUNTY OF SANTA BARBARA, BECAUSE SUPERVISOR DON KNABE AND I WANT TO RECOGNIZE AN INDIVIDUAL WHO HAS BEEN ON THE FRONTLINES OF FIRE SAFETY FOR THE PAST THREE DECADES IN THE COUNTY OF LOS ANGELES. AND WE'VE HAD THE OPPORTUNITY TO BE WITH MICHAEL ON VARIOUS, WITH CHIEF FREEMAN WITH VARIOUS CATASTROPHES WE'VE HAD IN THE COUNTY OF LOS ANGELES. AND CHIEF DYER HAS ALWAYS BEEN THERE DOING THE PROFESSIONAL JOB THAT HELPED TO PROTECT THE LIFE AND SAFETY OF OUR CITIZENS. AS I SAID, HE'LL BE LEADING A NEW CHAPTER IN HIS LIFE BY GOING TO THE COUNTY OF SANTA BARBARA, WHERE HE IS GOING TO BECOME NOW THE FIRE CHIEF. HIS CAREER HAS TAKEN HIM THROUGH VARIOUS ASSIGNMENTS, WHICH STARTED AS A LIFEGUARD. SO THOSE COLLEGE STUDENTS AND OTHERS WHO ARE LIFEGUARDS DURING THE SUMMER, THIS IS AN EXAMPLE OF A PERSON WHO CLIMBED THAT LADDER OF SUCCESS ALL THE WAY UP TO NOW FIRE CHIEF. HE HAD THE OPPORTUNITY, AS I SAID, BEFORE JOINING THE COUNTY FIRE DEPARTMENT IN 1986 TO BE THAT LIFEGUARD. AND THEN HE MOVED UP AS A FIREFIGHTER, A FIREFIGHTER PARAMEDIC, FIREFIGHTER SPECIALIST, FIGHTER CAPTAIN BATTALION CHIEF, ASSISTANT FIRE CHIEF, DEPUTY CHIEF, AND CHIEF DEPUTY, AND NOW MOVING ON TO THE COUNTY OF SANTA BARBARA. HE WAS CHIEF DEPUTY, HE WAS IN CHARGE OF BUSINESS OPERATIONS. HE SAW THE FIRE PREVENTION BUREAU, THE ADMINISTRATIVE BUREAU, SUPPORT SERVICES BUREAU, PLANNING DIVISION AND ORGANIZATIONAL DEVELOPMENT DIVISION. HE HOLDS A DEGREE, BOTH HIS BACHELOR'S AND MASTER'S DEGREE, FROM CALIFORNIA STATE UNIVERSITY AT NORTHRIDGE. AND ALONG WITH THAT, HE'S HAD OTHER SPECIAL TRAININGS AND CERTIFICATIONS FROM THE DEPARTMENT AND THE CALIFORNIA STATE FIRE MARSHAL. AND SO LET ME ASK SUPERVISOR KNABE TO SAY A FEW WORDS. WE'RE LOSING A GREAT LEADER TO OUR NEIGHBORING COUNTY, WHO I'M SURE THROUGH MUTUAL AID PACTS, WE'LL BE WORKING TOGETHER VERY SHORTLY. 

SUP. KNABE, CHAIRMAN: THANK YOU. CHIEF DYER HAS BEEN A GOOD FRIEND FOR MANY, MANY YEARS. WE WORKED VERY CLOSELY WITH HIM OVER THE YEARS IN VARIOUS ASPECTS. HE'S BEEN A GREAT FRIEND TO OUR DISTRICT AND TO OUR CITIZENS, BUT MOST IMPORTANTLY THE COUNTY. WHAT'S A SAD DAY FOR US, BUT I HAD NO IDEA THAT THIS MANY PEOPLE WANTED TO MAKE SURE YOU WERE RETIRING. [LAUGHTER.] AND SHOWING UP TO SAY GOODBYE. BUT SERIOUSLY, WE WISH YOU WELL UP THERE. WE DO INTERFACE WITH SANTA BARBARA ON C.S.A.C., AND OBVIOUSLY WITH THE MUTUAL AID AGREEMENTS, WE WILL, AS WELL. SO I'M SURE OUR PATHS WILL CROSS AGAIN. WE WISH YOU AND YOUR FAMILY THE VERY, VERY BEST. GODSPEED AND DO WELL UP THERE. WE'LL BE ROOTING FOR YOU. 

SUP. ANTONOVICH: SUPERVISOR KNABE AND I GIVE YOU THIS PRESENTATION. AND WE'LL ASK CHIEF FREEMAN TO SAY A FEW WORDS, AND MICHAEL, YOU CAN SAY A FEW WORDS AS WELL. THIS IS A DAY OF MICHAELS, RIGHT? ST. MICHAEL'S REALLY HAPPY TODAY, HUH? MICHAEL, WHY DON'T YOU GET IN, TOO. 

CHIEF P. MICHAEL FREEMAN: THANK YOU VERY MUCH. HONORABLE CHAIR, MEMBERS OF THE BOARD, WE JUST WANT TO JOIN WITH YOU AND GIVING OUR VERY BEST WISHES TO CHIEF DYER AS HE MOVES TO THE NORTH TO TAKE OVER THE COMMAND OF THE SANTA BARBARA COUNTY FIRE DEPARTMENT. CHIEF DYER STARTED HIS SERVICE HERE IN THE COUNTY OVER 31 YEARS AGO AS AN OCEAN LIFEGUARD. AND CERTAINLY IN LIFEGUARDING, THE FOCUS OF THE LIFEGUARD IS ON THAT ONE SINGLE INDIVIDUAL WHO IS IN DANGER. AND THAT SPIRIT HAS STAYED WITH CHIEF DYER THROUGHOUT HIS CAREER. AND AS A FIREFIGHTER, A FIRE OFFICER AND AS AN EXECUTIVE COMMANDER IN THE FIRE DEPARTMENT, HIS FOCUS HAS ALWAYS BEEN ON THAT PERSON, THAT MEMBER OF THE PUBLIC IN NEED. HE IS ENERGETIC, HE HAS DEMONSTRATED HIS CAPABILITIES IN NUMEROUS WAYS HERE WITHIN THE COUNTY, AS YOU HAVE RECOGNIZED THROUGH THE YEARS. AND IT IS A GREAT HONOR FOR US HERE IN THE COUNTY OF LOS ANGELES TO SEE HIM MOVE ON TO A VERY IMPORTANT POSITION AS FIRE CHIEF OF SANTA BARBARA COUNTY. WE KNOW HE WILL DO WELL. AND ALL WE SAY IS, BUY SOME FIRE HAWKS. GOOD LUCK TO YOU. [APPLAUSE.] 

MICHAEL DYER: WELL FIRST, I'D LIKE TO THANK YOUR HONORABLE BOARD FOR THE RECOGNITION THIS MORNING. IT'S BEEN AN HONOR AND A PRIVILEGE TO SERVE THE CITIZENS OF LOS ANGELES COUNTY IN ALL THESE DIFFERENT CAPACITIES FOR THE LAST 31 YEARS. I WANT TO SAY THE ONE THING THAT MAKES EVERY ORGANIZATION GREAT ARE THE MEN AND WOMEN THAT ARE PULLING EVERY DAY TO DO THE JOB. SOME OF THEM ARE BEHIND ME HERE. WHAT A GREAT, GREAT EXECUTIVE TEAM WE HAVE. AND WHEN THE EMERGENCIES HIT, ALL THESE PEOPLE BEHIND ME ARE PULLING, ALL THE MEN AND WOMEN OUT THERE, THE MECHANICS, THE ADMIN STAFF, EVERYBODY IS PULLING TO GET THE JOB DONE. AND IT'S BEEN REALLY AN HONOR AND A PRIVILEGE TO WORK WITH SUCH FINE INDIVIDUALS IN THIS DEPARTMENT FOR THE LAST 31 YEARS. THANK YOU VERY MUCH. [APPLAUSE.] 

SUP. YAROSLAVSKY: MR. CHAIRMAN? 

SUP. KNABE, CHAIRMAN: YES, SIR. 

SUP. YAROSLAVSKY: MR. CHAIRMAN, IF I COULD JUST ADD MY OWN COMMENTS ABOUT CHIEF DYER. WE'VE WORKED VERY CLOSELY TOGETHER, UNFORTUNATELY, OVER THE LAST FEW YEARS WITH ALL THE FIRES WE'VE HAD IN THE SAN FERNANDO VALLEY, WEST VALLEY, IN THE SANTA MONICA MOUNTAINS. AND HE'S A FIREFIGHTER'S FIREFIGHTER. HE'S GOT GOOD JUDGMENT. HE'S GOT CALM. HE THINKS AHEAD. AND I THINK THE PEOPLE -- I KNOW THAT THE PEOPLE OF LOS ANGELES COUNTY, ESPECIALLY THESE FIRE RAVAGED AREAS ARE SAFER AND THE BETTER FOR YOUR SERVICE TO OUR COUNTY. THE BEST COMPLIMENT I CAN PAY YOU, MIKE, IS WHEN A SUPERVISOR FROM UP IN SANTA BARBARA COUNTY CALLED ME TO CHECK YOU OUT, I SAID "I'LL SAY IT IN ONE SENTENCE. IF WE HAD A VACANCY AND HE APPLIED FOR THIS JOB, I COULD SUPPORT HIM FOR FIRE CHIEF IN LOS ANGELES COUNTY." AND THAT'S HOW GOOD YOU ARE IN MY BOOK. AND I KNOW I SPEAK FOR ALL OF MY CONSTITUENTS OUT THERE AND OUR MUTUAL CONSTITUENTS THAT HAVE BENEFITED FROM YOUR SERVICE. SO GOOD LUCK TO YOU UP THERE. DON'T BE A STRANGER. [APPLAUSE.] 

SUP. ANTONOVICH: NOW WE HAVE A LITTLE SHIATSU MIX, A LITTLE GIRL. SHE'S 32 MONTHS OLD, LOOKING FOR A HOME, WITH A YELLOW SWEATER, MATCHES HER LITTLE BEIGE COMPLEXION. SO ANYBODY WOULD LIKE TO ADOPT? HER NAME IS LADY LUCK. SHE HOPES HER LUCK HOLDS OUT FINDING A NICE HOME. BECAUSE SHE DOESN'T LIKE THE ALTERNATIVE. RIGHT? YEAH. AND WE HAVE ONE IN OUR OFFICE THAT LINDA ADOPTED A FEW YEARS AGO THAT'S OUR LITTLE MASCOT. SOMETIMES LEAVES A LITTLE TREAT FOR ME AT TIMES. AT INAPPROPRIATE TIMES. BUT WE GIVE HER LITTLE TREATS TO REWARD HER NOT TO DO THAT NEXT TIME. SO ANYBODY WHO'D LIKE TO ADOPT HER, YOU CAN CALL 562-728-4644. LIKES YOU, GLORIA. 

SUP. MOLINA: I THINK DON'S GOING TO TAKE HER. 

SUP. ANTONOVICH: DON'S GOING TO TAKE HER? LITTLE LADY LUCK, WE HOPE YOUR LUCK HOLDS OUT. 

SUP. KNABE, CHAIRMAN: ALL RIGHT. FIRST DISTRICT. ADJOURNMENTS? 

SUP. MOLINA: I DO NOT HAVE ANY THIS MORNING. 

SUP. KNABE, CHAIRMAN: OKAY. SUPERVISOR YAROSLAVSKY? 

SUP. YAROSLAVSKY: I DO HAVE SEVERAL, MR. CHAIRMAN. FIRST I'D LIKE TO ASK THAT WE ADJOURN IN MEMORY OF CARL MALDEN, THE OSCAR WINNING ACTOR KNOWN IN ROLES IN FILM SUCH AS A "STREETCAR NAMED DESIRE," "ON THE WATERFRONT," AMONG MANY OTHERS. HIS STARRING ROLE IN THE T.V. SERIES, "STREETS OF SAN FRANCISCO." HE PASSED AWAY AT THE AGE OF 97 AT HIS HOME IN BRENTWOOD, JUST A FEW DAYS AGO. HE IS SURVIVED BY HIS DAUGHTER, MILA DOERNER, AND MANY OTHER FAMILY FRIENDS AND RELATIVES. ALL MEMBERS. I WAS INFORMED YESTERDAY THAT FORMER LOS ANGELES CITY COUNCILMAN LOUIS NOWELL PASSED AWAY. LOUIE IS A FORMER CITY COUNCIL MEMBER AND CITY FIREFIGHTER. DIED AT THE AGE OF 94. AFTER SERVING IN THE FIRE DEPARTMENT FROM 1940 TO 1963, HE EMBARKED ON A SECOND CAREER AS A COUNCILMAN FOR THE FIRST DISTRICT OF WHAT WAS THEN NORTHEAST SAN FERNANDO VALLEY, WHERE HE ABLY SERVED THE PEOPLE OF THE CITY OF LOS ANGELES FOR 14 YEARS, UNTIL 1977. HE IS SURVIVED BY HIS WIFE OF 68 YEARS, MAXINE; HIS SON, JOHN, RECENTLY RETIRED AS A BATTALION CHIEF IN THE L.A. CITY FIRE DEPARTMENT, WHERE HE SERVED FOR MORE THAN 35 YEARS AND WAS PAST HONOREE AS FIREFIGHTER OF THE YEAR; AND OTHER FAMILY MEMBERS. I WOULD JUST SAY THAT WHEN I FIRST BECAME A COUNCILMAN IN THE CITY OF L.A. AT THE AGE OF 26, LOUIE WAS, OTHER THAN JOHN GIBSON, WAS THE OLDEST MEMBER OF THE COUNCIL AND HE TREATED ME AS AN EQUAL, WHICH WAS -- GAVE ME SOME GOOD COUNSEL, GOOD ADVICE, I LEARNED A LOT FROM HIM. WE DIDN'T SHARE OUR POLITICS, BUT HE WAS A GREAT MUNICIPAL OFFICIAL. SO I ASK THAT WE ADJOURN IN HIS MEMORY. ROBERT ELLSWORTH, LONGTIME RESIDENT OF THE THIRD DISTRICT IN MISSION HILLS, PASSED AWAY AT THE AGE OF 82. FOR MORE THAN 40 YEARS, ROBERT WORKED IN THE ENTERTAINMENT INDUSTRY AS A MOTION PICTURE COSTUMER, OUTFITTING SUCH WELL KNOWN CELEBRITIES AS ELVIS PRESLEY AND JAMES CAGNEY, AND WORKING WITH PROMINENT DIRECTORS LIKE STEVE SPIELBERG AND OTHERS. HE WAS ALSO ACTIVE IN HIS UNION AS SECRETARY-TREASURER AND LATER BUSINESS REPRESENTATIVES FOR I.A. LOCAL 705. HE IS SURVIVED BY HIS WIFE OF 62 YEARS, LOLA; TWO SONS, RON AND STEVE; AND A DAUGHTER, LINDA; SEVEN GRANDCHILDREN AND TWO GREAT GRANDCHILDREN. THOSE ARE MY ADJOURNING MOTIONS, MR. CHAIR. 

SUP. KNABE, CHAIRMAN: DID YOU HAVE ANY ITEMS THAT YOU WANTED TO CALL UP? 

SUP. YAROSLAVSKY: I DON'T THINK SO. 

SUP. KNABE, CHAIRMAN: OKAY. ALL RIGHT. FIRST OF ALL, I HAVE AN ADJOURNMENT TODAY THAT WE ADJOURN IN MEMORY OF ALBERTA BELL, THE GRANDMOTHER OF LORI BELL OF MY OFFICE. SHE WAS AFFECTIONATELY KNOWN AS DEAR. SHE PASSED AWAY AT THE AGE OF 90 ON JULY 2ND. SHE WAS A FINE ARTS PROFESSOR, MUSICIAN, CLOTHING DESIGNER. SHE ENJOYED SPENDING TIME WITH HER FAMILY AND BEING VERY ACTIVE IN HER CHURCH. SHE IS SURVIVED BY HER CHILDREN, GRANDCHILDREN, AND GREAT GRANDCHILDREN. SO SHE WILL BE MISSED BY ALL. SO ORDERED. SUPERVISOR ANTONOVICH? EXCUSE ME. BEFORE WE DO THAT, I DO HAVE A READ-IN. "THE CALIFORNIA STATE ASSOCIATION OF COUNTIES AND THE COUNTY WELFARE DIRECTORS ASSOCIATION OF CALIFORNIA JOINTLY EXAMINED CALIFORNIA'S SAFETY-NET PROGRAMS AND RELATED ECONOMIC BENEFITS FOR COMMUNITIES. NOT SURPRISINGLY, THE STUDY FOUND THAT THE STATE'S POOR ECONOMY AND HIGH UNEMPLOYMENT HAS LED TO AN INCREASE IN DEMAND FOR PUBLIC ASSISTANCE NOT ONLY FOR NEWLY ELIGIBLE APPLICANTS BUT ALSO FOR CURRENT PARTICIPANTS WHOSE PROGRAM EXIT HAS BEEN DELAYED. YET THE STATE SEEMS MORE COMPELLED TO PROPOSE DRAMATIC CHANGES TO HUMAN SERVICES THAT WILL SUPPOSEDLY CUT COSTS AND STREAMLINE PROGRAMS, BUT ARE IN FACT UNREALISTIC AND WILL POSE DIRE CONSEQUENCES FOR THOSE WHO DEPEND ON THEM. AS PART OF A SUSTAINED EFFORT TO CONVINCE THE STATE TO FOCUS ON PROVIDING ADEQUATE FUNDING FOR HUMAN SERVICES, THE C.S.A.C. BOARD OF DIRECTORS HAS ADOPTED THE ATTACHED RESOLUTION AND ENCOURAGE OUR INDIVIDUAL BOARDS TO ADOPT THE SAME RESOLUTION. SO I THEREFORE MOVE THAT THE BOARD OF SUPERVISORS ADOPT THE ATTACHED RESOLUTION, DIRECT OUR C.E.O., IN COLLABORATION WITH THE DEPARTMENTS OF CHILDREN AND FAMILY SERVICES AND PUBLIC SOCIAL SERVICES TO TRANSMIT THIS RESOLUTION TO C.S.A.C., C.W.D.A., AND THE COUNTY STATE LEGISLATIVE DELEGATION, TO ADVOCATE FOR ADEQUATE FUNDING OF STATE MANDATED HUMAN SERVICES PROGRAMS. AND I BELIEVE THAT WE CAN FIND -- THIS WAS BROUGHT TO OUR ATTENTION WITHIN THE LAST 72 HOURS, SO I WOULD MOVE URGENCY THERE'S A SECOND. WITHOUT OBJECTION, SO ORDERED. AND THEN MOVE THIS RESOLUTION BE FORWARDED AS SOON AS POSSIBLE TO THE AFOREMENTIONED PEOPLE IN THE MOTION. IS THAT CORRECT? CAN WE DO THAT? BECAUSE WE'RE ON A SHORT TIME FRAME HERE? IS THAT CORRECT? OKAY. SECONDED BY SUPERVISOR MOLINA. WITHOUT OBJECTION, SO ORDERED. THANK YOU. SUPERVISOR ANTONOVICH? 

SUP. ANTONOVICH: FIRST I WOULD LIKE TO JOIN IN WITH LOUIE NOWELL. LOUIE HELPED ME IN MY FIRST CAMPAIGN. AND HE AND HIS WIFE WERE AN INTEGRAL PART OF SAN FERNANDO VALLEY, QUITE INVOLVED WITH THE TUJUNGA COMMUNITIES AND SUN VALLEY, LAKE VIEW TERRACE, AND WAS A VERY FINE PUBLIC SERVANT. ALSO WITH KARL MALDEN. KARL MALDEN WAS BORN MALDEN SEKULVICH IN ILLINOIS TO A SERBIAN FAMILY, ACTIVE IN THE CHURCH. AND THEN CAME HERE AND BECAME AN OUTSTANDING ACTOR. HE SERVED HIS COUNTRY IN WORLD WAR II. AND HE ALSO WAS AN INTEGRAL PART OF THE REBUILDING OF THE ST. STEVENS' CATHEDRAL IN ALHAMBRA. HE ALWAYS WAS A COURTEOUS MAN. A REAL PROFESSIONAL. HIS WIFE AND HE CELEBRATED, I BELIEVE IT WAS THEIR 70TH ANNIVERSARY IN DECEMBER. AND HIS TWO DAUGHTERS, MILA AND CARA. BUT HE WAS WELL-RESPECTED WITHIN THE COMMUNITY. HE BELIEVED THAT CROATIANS AND SERBIANS SHOULD GET ALONG TOGETHER AND WORK TOGETHER SIDE BY SIDE. HE WAS A GOOD AMERICAN AND SERVED HIS PROFESSION, BOTH AS THE PRESIDENT OF THE MOTION PICTURE ARTS AND SCIENCES, WON AN ACADEMY AWARD, WON AN AWARD ALSO FOR HIS T.V. SERIES "STREETS OF SAN FRANCISCO." BUT HE WAS A GOOD MAN AND HE LEFT WITH HIS BOOTS ON AND A GOOD ROLE MODEL. ALSO I'D LIKE TO MOVE THAT WE ADJOURN IN MEMORY OF THERESA "TESS" TOWNER, PASSED AWAY AT THE AGE OF 97, AS WELL. WAS A LIFELONG RESIDENT IN ANTELOPE VALLEY. SHE WAS IN FARMING WITH HER HUSBAND, AND WAS QUITE INVOLVED WITH VARIOUS COMMUNITIES IN ANTELOPE VALLEY. THELMA GRAMATKY PASSED AWAY ON JUNE 27TH AT THE AGE OF 96 IN GLENDALE. HER SON JOHN AND THREE GRANDCHILDREN, TWO GREAT GRANDCHILDREN. SHE WAS INVOLVED IN THE P.T.A. AT JOHN MARSHALL HIGH SCHOOL IN LAS FILAS AREA AND ALSO IN OTHER COMMUNITY GROUPS. PATRICK CUMMINGS FITZPATRICK PASSED AWAY AT THE AGE OF 80. HE WAS A GRADUATE OF LOYOLA HIGH SCHOOL AND SANTA CLARA UNIVERSITY, AND WAS INVOLVED AS AN INSURANCE EXECUTIVE FOR MORE THAN 50 YEARS. HE WAS A PROUD MEMBER OF THE HOLY FAMILY PARISH IN LOS ANGELES COUNTRY CLUB. RODRIGO ARAMAS, PROBATION OFFICER, PASSED AWAY ON JUNE 28TH. HE WAS INVOLVED IN THE ANTELOPE VALLEY, CAMP CHALLENGER, AND ALSO WAS KNOWN FOR HIS SKILLED PENMANSHIP AND COMPUTER WHIZ, WHO DEVELOPED MANY COMPUTER SYSTEMS UTILIZED IN THE CAMP SYSTEM, UTILIZED BY THE CAMP INSTITUTIONS. HE WAS A RESIDENT OF KERN COUNTY, SERVED IN THE MILITARY. HE WAS A MEMBER OF THE UNITED STATES MARINE CORPS. EDWARD CLOSTERMAN. RAISED IN GLENDALE. EXCUSE ME, PASSED AWAY IN GLENDALE. FORMER F.B.I. AGENT, GRADUATE OF U.C.L.A. HE WAS MARRIED FOR 56 YEARS. HE MET HIS WIFE AS AN F.B.I. AGENT WHEN HE WAS IN FLORENCE, SOUTH CAROLINA 56 YEARS AGO. AND THEN CAME BACK HERE IN 1964 AND LEFT THE F.B.I. AND STARTED SHIELD SECURITY GUARD COMPANY. AND HE LEAVES HIS CHILDREN, EDWARD, JR., AND KENNETH GREG. HE WAS ACTIVE IN THE GRANDVIEW PRESBYTERIAN CHURCH IN GLENDALE. RUTH HOUSTON PASSED AWAY AT THE AGE OF 80. SHE WAS A RESIDENT OF ANTELOPE VALLEY FOR THE PAST 20 YEARS AND WORKED WITH THE LOS ANGELES COUNTY SHERIFF'S DEPARTMENT. AND DURING HER FREE TIME, SHE WAS INVOLVED WITH THE ANTELOPE VALLEY COLLEGE. THOSE ARE MY ADJOURNMENTS. AND I'D LIKE TO CALL UP ITEM 12. 

SUP. KNABE, CHAIRMAN: IT IS BEING HELD FOR A MEMBER OF THE PUBLIC. MR. SACHS? 

ARNOLD SACHS: GOOD MORNING. ARNOLD SACHS. I HELD ITEM 12 BECAUSE A COUPLE WEEKS AGO YOU HAD A HUGE DISCUSSION HERE REGARDING THE SHARING OF INFORMATION FOR YOUR FAMILY SERVICES., AND THE FACT THAT YOU'RE TRYING TO IMPLEMENT A PROGRAM WITH THAT. SO I'M WONDERING IF THIS ENTERPRISE CONTENT MANAGEMENT STANDARD WOULD RELATE TO THAT AT ALL? OR WOULD IT AFFECT IT? THE ABILITY OF THE DEPARTMENTS TO SHARE THE INFORMATION FOR FAMILY SERVICES. THANK YOU. 

SUP. KNABE, CHAIRMAN: WITHOUT OBJECTION, SO ORDERED. 

SUP. ANTONOVICH: 16. 

SUP. KNABE, CHAIRMAN: 16, MR. SACHS? 

ARNOLD SACHS: YEAH, I HELD 16. WELL ACTUALLY, I WAS GOING TO HOLD 1-D BECAUSE IT REFERS PRETTY MUCH -- YOU'RE OFFERING THE WEINGART CENTER ASSOCIATION CONTRACT FOR $200,000 FOR HOUSING LOCATER CONSULTANT SERVICES FOR G.R. SINGLE ADULTS. AND I HAD ORIGINALLY HELD 1-D BECAUSE I WAS WONDERING IF THAT HAS ANY KIND OF CARRYOVER OR INFLUENCE WITH THIS HOMELESSNESS PREVENTION AND RAPID RE-HOUSING PROGRAM. SINCE BASICALLY YOU'RE LOOKING FOR HOUSING, I WOULD IMAGINE THE RAPID RE-HOUSING PROGRAMS IS FOR FAMILIES? BUT WOULD ALSO INCLUDE INDIVIDUALS? AND YOU'RE GOING TO PAY WEINGART CENTER $200,000 TO LOOK FOR HOUSING, ALSO. ANY RELATIONSHIP BETWEEN THE TWO? THANK YOU. 

SUP. KNABE, CHAIRMAN: MOVED BY SUPERVISOR ANTONOVICH, SECONDED BY SUPERVISOR YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. 

SUP. ANTONOVICH: THAT'S ALL, THANK YOU. 

SUP. KNABE, CHAIRMAN: OKAY. WE ARE GOING TO CALL UP, LET'S SEE, NO -- YOU HELD 3-D? 

ARNOLD SACHS: I DID HOLD 3-D. 

SUP. KNABE, CHAIRMAN: YOU HELD 19. ALSO, IF WE CAN TUNE INTO LANCASTER, NICOLE PARSONS, AS WELL, HELD THOSE TWO ITEMS. MR. SACHS, IF YOU CAN GO AHEAD? 

ARNOLD SACHS: WELL, 3-D, AND EVEN IN YOUR AGENDA IT RELATES TO ITEM 19. 3-D, YOU'RE AUTHORIZING THE EXECUTIVE DIRECTOR TO ACCEPT $4 MILLION, ALMOST $5 MILLION IN STATE NEIGHBORHOOD STABILIZATION PROGRAM FUNDS AND TO EXECUTE A GRANT AMENDMENT WITH THE STATE AND ANY SUBSEQUENT AMENDMENTS NECESSARY TO RECEIVE THE STATE'S NEIGHBORHOOD STABILIZATION PROGRAM FUNDS. BUT IN 19, YOU'RE RECOMMENDING THAT THE COMMUNITY DEVELOPMENT COMMISSION ACT AS THE AGENT OF THE COUNTY IN ALL MATTERS PERTAINING TO THE APPLICATION FOR FUNDS FROM THE STATE'S NEIGHBORHOOD STABILIZATION PROGRAM. SO IF ITEM NO. 3-D HAS THE EXECUTIVE DIRECTOR PRETTY MUCH TRYING TO MAKE AMENDMENTS AND A GRANT AGREEMENT WITH THE STATE FOR ANY -- TO RECEIVE THESE FUNDS, WHAT WOULD THE COMMUNITY DEVELOPMENT COMMISSION PICK UP THAT THE STATE -- THAT THE EXECUTIVE DIRECTOR WOULDN'T? AND THAT BEING THE CASE, WHY WOULDN'T THE STATE, THE EXECUTIVE DIRECTOR, PICK UP ALL THOSE FUNDINGS AND YOU NEED TO HAVE THE COMMUNITY DEVELOPMENT COMMISSION? 

SUP. KNABE, CHAIRMAN: HE'S THE EXECUTIVE DIRECTOR OF THE COMMUNITY DEVELOPMENT COMMISSION. 

ARNOLD SACHS: OH, HE'S THE EXECUTIVE DIRECTOR OF THE COMMUNITY DEVELOPMENT COMMISSION. 

SUP. KNABE, CHAIRMAN: THEY'RE INTERRELATED. SO ONE HAS AN ACTION AND THE OTHER ONE IS TO ENGAGE THE COMMISSION AS THE AGENT. OKAY? 

ARNOLD SACHS: IT'S LIKE A PASS- THROUGH, THOUGH. THANK YOU. 

SUP. KNABE, CHAIRMAN: THANK YOU. AND THEN FROM LANCASTER, I BELIEVE, ARE WE HOOKED UP? NICOLE PARSONS HAS HELD 3-D AND 19, AS WELL. THEY ARE BOTH RELATED. DO YOU WANT TO GO AHEAD AND TESTIFY? 

NICOLE PARSON: YES. HI, I'M GOING TO TESTIFY ON BEHALF OF JUST BEING A CITIZEN IN GENERAL. AND OVER HERE IN LANCASTER, IN ANTELOPE VALLEY IN L.A. COUNTY, I JUST WANT TO ASK YOU, MR. MAYBE ANTONOVICH OR THE BOARD IF YOU GUYS COULD LOOK AT LIKE MAYBE IF THERE'S A FORM TO APPEAL OR SOMETHING? BECAUSE I FEEL THAT I'VE BEEN WRONGED AND NOT ONLY ME. I'M GOING TO SPEAK JUST MAYBE ABOUT ME. BUT IT'S NOT JUST ONLY ABOUT ME. BUT I WAS WRONGED IN APPLYING TO YOU GUYS MAKING A CLAIM. AND, SEE, THAT'S WHERE LIKE OVER HERE, WE'RE JUST LIKE A WHOLE BUNCH OF FARMERS, LIKE, RIGHT? AND SO WHEN I WAS LITTLE, I JUST WANTED BLACK FEET, YOU KNOW, LIKE ALL THE OLDER GIRLS. AND THEN BUT LIKE JUST FROM BEING FARMERS, YOU KNOW, WE'RE LIKE THE BIGGEST INNOVATORS. AND SO WE ALWAYS GET MISTAKEN. AND SO LIKE THE HOPE 6, THE HOPE 6, LIKE THIS PROGRAM, OKAY, I WAS PROUD OF IT. AND I TURNED IN THE RESEARCH IN JULY AND THEN I HAVE THE BRIDGE IN AUGUST. SO IN THE HOSPITAL, I WAS PROUD TO SPEAK ABOUT, THEY'RE LIKE WHAT DO YOU DO? AND I SAY I RESEARCH AND I DO, YOU KNOW, FOR GOVERNMENT RESEARCH. AND THEN SO YOU KNOW, THEY TOOK HER. AND THEN THEY KILLED MY DOG ON SEPTEMBER 8TH WHEN I ASKED FOR THE WELFARE PROVISION BECAUSE I DIDN'T HAVE THE MONEY TO GET HER. AND THEN I CALLED MR. ANTONOVICH'S OFFICE, AND THEN THEY CALLED LANCASTER SHELTER AND THEN THEY KILLED HER. AND THEN ABOUT MY DAD, MY DAD, THERE WAS NO COURT ORDER. IT WAS LIKE AND ILLEGAL EVICTION. AND THEN MY DAD DIED. OKAY? AND THEN, SO CAN YOU GUYS, IS THERE A FORM OR MISS MOLINA, YOU SAID THAT YOU GUYS JUST DENY. IT'S LIKE INJUNCTION, INJUNCTION. AND I'M JUST SO BEHIND IN MY PROFESSIONAL WORKS BECAUSE OF THE COUNTY AND JUST DENYING ME. AND I JUST WANT IT TO BE RIGHT. LIKE THE WATER, IT'S GOING TO BE ALL WRONG. IT'S GOING TO BE ALL WRONG. BASICALLY EVERYONE'S JUST GOING TO THROW THEIR WASTE OR WHATEVER OUT THE WINDOW. AND THERE'S NO ONE WATCHING IT. BUT I'M PROFESSIONAL. I'M JUST A FARMER, OKAY? I MEAN CAN YOU ANSWER, PLEASE? 

SUP. KNABE, CHAIRMAN: YOUR TIME HAS EXPIRED. SUPERVISOR ANTONOVICH'S OFFICE, SOMEONE WILL CONTACT YOU OR YOU CAN CONTACT SOMEONE UP THERE. OKAY. ITEM 3-D AND 19 IS BEFORE US. MOVED BY SUPERVISOR ANTONOVICH. SECONDED BY SUPERVISOR YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. WE'RE GOING TO CALL ITEM 4. 

ARNOLD SACHS: ITEM 4. YESTERDAY'S L.A. TIMES THERE WAS AN ARTICLE IN THE BUSINESS SECTION REGARDING THE P.U.C.'S GOING TO CONSIDER HAVING HEARINGS AND RAISING THE THRESHOLD, OR RAISING THE CEILING ON THE AMOUNT OF ELECTRICITY THAT THE UTILITIES CAN BUY BACK FROM 4 PERCENT TO 10 PERCENT. AND MY QUESTION BEING, SINCE THIS ITEM REGARDS SOLAR INITIATIVE, SOLAR PANEL INITIATIVES, WILL THE COUNTY BOARD OF SUPERVISORS BE SENDING A LETTER TO THE P.U.C. OR TO THE STATE IN SUPPORT OF RAISING THE THRESHOLDS TO 10 PERCENT? BECAUSE THE 4 PERCENT THAT IS CURRENTLY THE CEILING, THAT'S WHAT THE UTILITIES ARE ALLOWED TO BUY BACK FROM THEIR CONSUMERS, IS FAST APPROACHING. AND ONCE THAT CEILING IS REACHED, THEY WON'T BE BUYING ANYMORE ELECTRICITY FROM PEOPLE WHO HAVE SOLAR PANELS. JUST CURIOUS TO KNOW. YOU SENT LETTERS TO THE STATE LEGISLATION AND THE GOVERNOR. WOULD YOU BE SENDING A LETTER TO THE P.U.C. SAYING THAT YOU SUPPORT A RAISE OF THE CEILING TO 10 PERCENT FOR SOLAR, FOR PEOPLE WHO WANT TO INVEST IN SOLAR POWER? THANK YOU. 

SUP. KNABE, CHAIRMAN: THANK YOU. MOVED BY SUPERVISOR YAROSLAVSKY. THE CHAIR WILL SECOND. WITHOUT OBJECTION, SO ORDERED. OKAY, WE HAVE PUBLIC COMMENT. ARNOLD SACHS? RON MILLER? AND SUSAN BURTON. 

ARNOLD SACHS: YOU ALMOST SET A RECORD. THANK YOU. LAST MONDAY, OR IT MIGHT HAVE BEEN TUESDAY, THE "DAILY BREEZE" HAD A STORY ON MEASURE "R" AND THE EFFECTS FROM THE FALLOUT THAT WILL OCCUR IN THE SOUTH BAY. AND ONE OF THE STORIES IN THAT, ONE OF THE BY LINES IN THAT STORY WAS REGARDING THE HARBOR SUBDIVISION RAIL LINE, HOW THE HALF CENT SALES TAX WILL BE USED TO DEVELOP THAT. WELL, THEY'VE HAD SEVERAL, MORE THAN SEVERAL. THEY'VE HAD MAYBE PRETTY CLOSE TO 10 OUTREACH PROGRAMS IN THE SOUTH BAY REGARDING THAT. AND I HAVE GONE TO THREE. THEY'VE HAD PLENTY OF DIAGRAMS. THEY'VE HAD PROPOSED ROUTES. BUT ONE OF THE THINGS THEY SAID WE HAVE NO FUNDING SOURCE. EVEN WITH MEASURE "R." SO, YOU GET TWO SIDES OF THE STORY. YOU HAVE PEOPLE FROM THE M.T.A. TELLING YOU THEY HAVE NO FUNDING SOURCE AND YOU HAVE THESE INSIDE WRITERS FROM THE "DAILY BREEZE" TELLING YOU THAT MEASURE "R" WILL BUILD THE HARBOR SUBDIVISION. YOU COULDN'T BE FURTHER APART IF YOU HAD BOTH ENDS OF THE POLES ON THE GLOBE. I'M TRYING TO GET SOME CLEAR THINKING HERE SO THAT THIS DOESN'T TURN INTO ANOTHER, IT'S FAST APPROACHING THAT, ANOTHER DEBACLE LIKE THE RED LINE OR THE WILSHIRE CORRIDOR LINE OR THE GOLD LINE ITSELF THAT WAS NEVER COMPLETED. JUST A LITTLE BIT OF DIRECTION FROM THE PEOPLE WHO SIT ON THE M.T.A. BOARD WOULD BE REALLY HELPFUL TO THE PUBLIC INSTEAD OF WATCH ME PULL A RABBIT OUT OF MY HAT ROUTINE. AND I ALSO WANTED TO TALK A LITTLE BIT ABOUT THIS EVENT THAT'S GOING ON IN DOWNTOWN L.A. WITH THE MICHAEL JACKSON MEMORIAL. AND IN A RELATED ITEM, THERE WAS A STORY IN THE L.A. TIMES REGARDING THE HOME DEPOT CENTER. AND A.E.G., BEING THAT GREAT CORPORATE CITIZEN THAT THEY ARE, OFFERED THE CITY OF CARSON TO FUND THE OVERTIME FOR THEIR CODE ENFORCEMENT OFFICERS SO THAT THEY COULD GO OUT AND TICKET AND CONFISCATE THE PEOPLE THAT GRILL HOT DOGS IN THESE LITTLE CARTS THAT ARE UNLICENSED. THAT BEING SAID, A.E.G. BEING THAT GREAT CORPORATE CITIZEN, HOPEFULLY WILL STEP UP AND OFFER TO PAY THE OVERTIME THAT'S BEING INCURRED BY MAYBE THE M.T.A. OR THE SHERIFF'S DEPARTMENT OR THE CITY OF L.A. FOR THE COSTS OF RUNNING THE PRIVATIZING OF DOWNTOWN STAPLES CENTER THAT'S GOING TO APPROACH $4 BILLION. THAT BEING SAID, THE BUDGET DISCUSSIONS REGARDING THE SHERIFF'S DEPARTMENT, WHAT CONCERNS ME ABOUT THAT IN THE STORY IN THE L.A. TIMES WAS THAT THE BUDGET WENT FROM $1.6 BILLION TO 2.05. 

SUP. KNABE, CHAIRMAN: THANK YOU. 

ARNOLD SACHS: $100 MILLION A YEAR. THANK YOU. 

SUP. KNABE, CHAIRMAN: MR. MILLER? 

RON MILLER: GOOD MORNING, SUPERVISORS. THANK YOU FOR THE OPPORTUNITY TO SPEAK. I'M RON MILLER, AND I REPRESENT THE L.A. ORANGE COUNTY BUILDING AND CONSTRUCTION TRADES. I'M ALSO A REPRESENTATIVE OF PLUMBERS' LOCAL 78. I WANT TO MAKE SURE THAT THE COUNTY IS COGNIZANT THAT ALL THE A.R.R.A. FUNDS HAVE A PREVAILING WAGE STANDARD ATTACHED TO THEM, AND WE WOULD LIKE, IF IT IS POSSIBLE, TO INTRODUCE PUBLICLY THAT THE BUILDING TRADES ARE AVAILABLE TO DISCUSS A PROJECT LABOR AGREEMENT ON ALL THE A.R.R.A.-RELATED PROJECTS. WE KNOW AND UNDERSTAND THAT THE COUNTY IS INTERESTED IN THE MOST EFFECTIVE USE OF THESE FUNDS, AND IN INSURING THAT THE LOCAL RESIDENTS ARE WORKING ON THESE PROJECTS AND HAVE AN OPEN OPPORTUNITY TO PARTICIPATE IN APPRENTICESHIP. WE HAVE A VERY RESPECTABLE TRACK RECORD WHEN IT COMES TO PROMOTING LOCAL HIRE WITH VARIOUS PUBLIC AGENCIES WITHIN THE CITY AND COUNTY. THE LOS ANGELES ORANGE COUNTY BUILDING AND CONSTRUCTION TRADES HAVE BEEN VERY SUCCESSFUL WITH NEGOTIATING PROJECT LABOR AGREEMENTS WITH VARIOUS PUBLIC AGENCIES. THESE P.L.A.S CREATE A LEVEL AND FAIR PLAYING FIELD FOR HONEST AND FAIR CONTRACTORS BIDDING THE WORK. WE WILL LOOK FORWARD TO WORKING WITH THIS BOARD IN THE TOUGH ECONOMIC TIMES TO PUT YOUR CONSTITUENTS, OUR MEMBERS, AND MEMBERS OF THE LOCAL COMMUNITY TO WORK. THANK YOU. 

SUP. KNABE, CHAIRMAN: THANK YOU, RON. SUSAN BURTON? AND THEN I'LL ASK JOSHUA KIM TO JOIN US. 

SUSAN BURTON: HI, MY NAME IS SUSAN BURTON AND I'M DIRECTOR OF THE NEW WAY OF LIFE REENTRY PROJECT. ALSO A MEMBER OF ALL OF US OR NONE. WE WERE HERE THREE WEEKS AGO WITH A CONCERN AROUND THE IMPLEMENTATION OF THESE 10,000 JOBS THAT ARE COMING FORWARD. YOU KNOW, AS YOU KNOW, I'VE WORKED WITH THE FORMER PRISONER COMMUNITY FOR THE LAST 10 YEARS. AND IT'S A HUGE COMMUNITY OF PEOPLE IN ALL OF YOUR DISTRICTS. I'M IN THE SECOND DISTRICT. MY SUPERVISOR'S NOT HERE. I WISH HE WAS HERE. BUT WHEN WE WERE HERE, THERE WAS A STATEMENT MADE BY THE SUPERVISOR FOR THE WORK SOURCE TO CONNECT WITH US AND ADDRESS THE CONCERNS WE HAD ABOUT THE LANGUAGE THAT WOULD GO OUT INTO THE CONTRACT. AND IT HASN'T HAPPENED. WE'VE MADE NUMEROUS CALLS AND HAVE NOT BEEN ABLE TO ENGAGE IN A CONVERSATION WITH THE WORK SOURCE CENTER. YOU KNOW THERE'S HUNDREDS OF THOUSANDS OF PEOPLE IN LOS ANGELES COUNTY WHO HAVE CONVICTIONS WHO ARE STRUGGLING TO ACTUALLY HAVE EMPLOYMENT. AND YOU KNOW, MY CONCERN IS A BETTER LOS ANGELES. AND I'M SURE YOUR CONCERN ALSO IS A BETTER LOS ANGELES, A FAIR LOS ANGELES, THE ABILITY FOR PEOPLE TO GET JOBS AFTER CONVICTIONS AND HOW DO WE -- MY QUESTION AND MY THOUGHT IS: IS HOW DO WE ACHIEVE THAT? WHAT DO WE DO TO ACTUALLY MAKE THAT HAPPEN? ACCORDING TO THE TIMES, DEPARTMENT OF CORRECTIONS AND OTHER ENTITIES, THERE'S GOING TO BE A LARGE, LARGE RELEASE AND INFLUX OF PEOPLE COMING BACK INTO THIS COMMUNITY. MY THOUGHTS AND CONCERNS ARE: WHAT DO WE DO TO ADDRESS THEM? ARE THERE ANY PLANS GOING DOWN? ARE THERE ANY ROUND TABLES? WHAT CAN WE DO TO WORK COLLECTIVELY TO MAKE THAT HAPPEN? NOT ONLY IN THE SECOND DISTRICT BUT THROUGHOUT THE ENTIRE COUNTY OF LOS ANGELES? AGAIN, THE COMMUNITY'S WELFARE, WELL-BEING, PUBLIC SAFETY, AND A FAIR OPPORTUNITY FOR PEOPLE TO REBUILD THEIR LIVES AFTER THEY ARE RELEASED IS THE CONCERN. THE LAST TIME, SUPERVISOR KNABE, I WAS HERE, YOU SAID THAT YOU WOULD SEND SOMEONE TO TALK TO ME TO ADDRESS THOSE CONCERNS, TO FOLLOW-UP AFTER THIS MEETING THAT I'M JUST NOT SPEAKING AT THIS MEETING AND THAT'S THE END OF IT. AND I REQUEST TODAY AGAIN IF YOU COULD HAVE SOMEONE TO TALK TO ME TO ACTUALLY ADDRESS THE CONCERNS OF A FAIR CONTRACT FOR THESE JOBS AND A CHANCE FOR PEOPLE TO REBUILD THEIR LIVES. IF THEIR LIVES DON'T GET REBUILT, NOT ONLY ARE THEY DESTROYED, BUT PEOPLE AROUND THEM ARE DESTROYED, TOO. 

SUP. KNABE, CHAIRMAN: OKAY, JOSHUA KIM. 

JOSHUA KIM: MY NAME IS JOSHUA KIM, I'M A STAFF ATTORNEY AT NEW WAY OF LIFE REENTRY PROJECT. I'M HERE TO ADDRESS THE SAME CONCERN THAT SUSAN DID, ABOUT THE CREATION OF 10,000 NEW JOBS THROUGH THE SOUTH BAY WORKFORCE INVESTMENT BOARD WITH THE FEDERAL A.R.R.A. MONEY. THE LAST TIME WE WERE HERE, ABOUT THREE WEEKS AGO, THERE WAS A MENTION THAT THE SOUTH BAY WORKFORCE INVESTMENT BOARD WAS CONSIDERING CREATING A SPECIAL PROGRAM THAT JUST TARGETS PEOPLE WITH CRIMINAL RECORDS BECAUSE THEY ARE A DIFFICULT POPULATION TO PLACE IN EMPLOYMENT. HOWEVER, STILL BECAUSE OF THE LACK OF COMMUNICATION BETWEEN THEM AND US, A LOT OF QUESTIONS REMAIN FOR US UNANSWERED. FOR INSTANCE, ARE PEOPLE WITH NECESSARY EXPERIENCE AND EXPERTISE BEING INVOLVED IN CREATING THIS PROGRAM? WHAT KIND OF JOBS ARE BEING TARGETED AND CREATED? BECAUSE THERE ARE, IN FACT, LAWS ON THE BOOK THAT MAKE CERTAIN JOBS INACCESSIBLE TO THESE PEOPLE, AND HOW MUCH MONEY ARE WE TALKING ABOUT HERE? HOW MANY JOBS ARE WE TALKING ABOUT? I JUST WANT TO MENTION THAT AS A GENERAL PRINCIPLE, PUBLIC SAFETY IS NOT ACHIEVED THROUGH SEGREGATION, BUT THROUGH INTEGRATION. AND IF SPECIAL PROGRAMS ARE MADE AVAILABLE FOR A SPECIAL GROUP OF PEOPLE, THAT THEY MUST TAKE INTO CONSIDERATION THE SPECIAL NEEDS OF THESE PEOPLE, THE TARGET POPULATION, AND THIS SPECIAL CATEGORY OF PEOPLE, PEOPLE WITH CRIMINAL RECORDS. I WANT TO REMIND THE BOARD THAT HISTORICALLY THEY ARE LEFT OUT FOR A LATER CONSIDERATION TIME AND TIME AGAIN. AND IN THE END, THEY REMAIN OUTSIDE OF OUR MAINSTREAM AND THEY REMAIN IN THEIR LIVES OF DESPERATION AND ALIENATION. AND THEY KEEP GOING THROUGH THIS VICIOUS CYCLE OF ALIENATION, POVERTY AND CRIME. THIS IS A GOOD OPPORTUNITY FOR THE BOARD, FOR THE COUNTY TO TAKE A GOOD HEALTHY STEP TOWARDS INTEGRATING THEM BACK INTO OUR COMMUNITY AND MAKING ALL RESOURCES AVAILABLE TO THEM AND I ENCOURAGE THE BOARD TO TAKE A SPECIAL CONSIDERATION OF THIS. THANK YOU VERY MUCH. 

SUP. KNABE, CHAIRMAN: THANK YOU. I CAN ASSURE YOU, THERE'S A LOT OF PEOPLE OUT THERE INTERESTED IN THE 10,000 JOBS. AND IT'S GOING TO BE A VERY DIFFICULT SITUATION. WE'RE WORKING WITH COMMUNITY-BASED GROUPS AND ORGANIZATIONS, CHURCHES, CITIES. IT'S NOT JUST BEING RUN BY THE COUNTY. SO THERE'S A LOT OF ACTIVITY AROUND THERE. A LOT OF PEOPLE WANT THOSE JOBS BECAUSE REGARDLESS OF WHAT THEIR PAST HISTORY IS, THEY'RE STILL NOT WORKING. 

JOSHUA KIM: AND ACTUALLY WHAT WE'RE SAYING IS WE DON'T WANT A SPECIAL SET-ASIDE FOR PEOPLE WITH CRIMINAL RECORDS. WE SIMPLY WANT THE PLAYING FIELD TO BE LEVEL. THAT'S WHAT WE WANT. 

SUP. KNABE, CHAIRMAN: THANK YOU. 

JOSHUA KIM: THANK YOU. 

SUP. KNABE, CHAIRMAN: I BELIEVE YOU WILL READ US INTO CLOSED SESSION, PLEASE, THANK YOU. 

CLERK SACHI HAMAI: IN ACCORDANCE WITH BROWN ACT REQUIREMENTS, NOTICE IS HEREBY GIVEN THAT THE BOARD OF SUPERVISORS WILL BE CONVENING IN CLOSED SESSION TO DISCUSS ITEM NO. CS-2, CONFERENCE WITH LEGAL COUNSEL REGARDING SIGNIFICANT EXPOSURE TO LITIGATION, ONE CASE, AND ITEM NO. CS-3, CONFERENCE WITH LABOR NEGOTIATORS, WILLIAM T FUJIOKA, CHIEF EXECUTIVE OFFICER, AND DESIGNATED STAFF AS INDICATED ON THE POSTED AGENDA. THANK YOU. 
REPORT CLOSED SESSION ACTION TUESDAY, JULY 7, 2009

In Open Session, item CS-1 was continued one week to July 14, 2009, at the request of Supervisor Ridley-Thomas. 
No reportable action was taken on items CS-2 or CS-3. 


I, JENNIFER A. HINES, Certified Shorthand Reporter 

Number 6029/RPR/CRR qualified in and for the State of California, do hereby certify:

     That the transcripts of proceedings recorded by the Los Angeles County Board of Supervisors July 7, 2009,

were thereafter transcribed into typewriting under my direction and supervision;

     That the transcript of recorded proceedings as archived in the office of the reporter and which have been provided to the Los Angeles County Board of Supervisors as certified by me.

     I further certify that I am neither counsel for, nor related to any party to the said action; nor in anywise interested in the outcome thereof.

    
IN WITNESS WHEREOF, I have hereunto set my hand this 10th day of July 2009, for the County records to be used only for authentication purposes of duly certified transcripts      

as on file of the office of the reporter.

                   

JENNIFER A. HINES 
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